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1 Apžvalga

Šioje  Atvirųjų  standartų  vartotojo  vadovo  dalyje  pateikiami  bendrieji  apibrėžimai  ir  sąvokos, 

supažindinama su atviraisiais ir uždarais standartais, laisva atvirojo kodo programine įranga, susijusiais 

Lietuvos, Latvijos ir Europos Komisijos teisės aktais bei kitų šalių patirtimi.

1.1 Standartai

Standartas – tai bendras susitarimas dėl kažko, nustatant normas, taisykles ir reikalavimus. Pagal tai, 

kas ir kaip gali susitarti ir kaip tie susitarimai bus skelbiami bei pagal jų veikimo principus, standartai gali 

būti  skirstomi  į  atviruosius  (laisvus)  ir  uždarus  (kurie  dažniausiai  priklauso  vienam  gamintojui  arba 

gamintojų grupei – kitaip sakant jie yra nuosavybiniai). Dokumento formatas taip pat yra standartas.

Atviruosius  standartus  bet  kas  gali  laisvai  naudoti,  matyti  jų  aprašymus  (specifikacijas)  bei  reikšti 

pasiūlymus  dėl  tobulinimo.  Lietuvos  Respublikos  Vyriausybės  patvirtintoje  elektroninės  valdžios 

koncepcijoje1 parašyta:  „Atviros  technologijos,  atviri  formatai – tokie  keitimosi  duomenimis  formatai  ir 

protokolai, kurie yra išsamiai aprašyti ir kuriais galima laisvai nemokamai naudotis.“

Atvirieji  standartai,  aprašantys  Interneto  technologijas,  lėmė  Interneto  populiarumą  ir  leido  šioms 

technologijoms nugalėti konkuruojančias nuosavybines technologijas. Tik šių technologijų atvirumas leido 

atsirasti  globaliai  techninių,  programinių  priemonių  bei  paslaugų  rinkai.  Iki  tol  egzistavę  informaciniai 

kompiuterių tinklai arba perėjo prie Interneto technologijų (MSN, AOL), arba išnyko (CompuServe).

Atvirųjų standartų dominavimas leidžia vartotojui laisvai rinktis elektroninio pašto serverius, elektroninio 

pašto  klientus,  žiniatinklio  serverius,  naršykles  ir  beveik  nesirūpinti  suderinamumo  klausimais.  Taigi, 

naudojamų  standartų  atvirumas  yra  Interneto  esminė  savybė,  ir  jos  naudojimas  padės  pasinaudoti 

veiksniais, kurie sąlygojo Interneto populiarumą. 

Ekonominis atvirųjų standartų naudojimo efektas yra toks, kad jie sukuria sąžiningą, konkurencingą 

aplinką, skatina konkurenciją tarp tiekėjų, ir tokiu būdu sudaro geresnes sąlygas vartotojui.

Pagrindiniai atvirųjų formatų (standartų) principai:

– Prieinamumas. Jie yra laisvai prieinami visiems (ir perskaitymo, ir įgyvendinimo prasme).

– Padidina  galutinio  vartotojo  pasirinkimo  laisvę.  Atvirieji  standartai  sukuria  sąžiningą, 

konkuruojančią  rinką  standarto  realizavimams.  Jie  „nepririša“  vartotojo  prie  konkretaus  tiekėjo  ar 

tiekėjų grupės.

– Nemokami. Atvirąjį standartą galima laisvai realizuoti visiems, už tai negali būti imamas mokestis 

(mokestis gali būti imamas tik už atitikimo standartui patikrinimą – sertifikavimą).

– Jokios diskriminacijos. Atvirieji standartai bei organizacijos, kurios juos administruoja negali teikti 

pirmenybės  vienam  realizuotojui  prieš  kitą  dėl  jokių  kitų  priežasčių  išskyrus  techninius  pateiktos 

realizacijos atitikimus standartui. Sertifikavimo organizacijos turi sudaryti galimybę patikrinti atitikimą 

standartams ir  pigiems bei  nemokamiems įgyvendinimams (pvz.,  World Wide Web konsorciumas 

leidžia bet kam nemokamai patikrinti (X)HTML ar CSS dokumentų atitikimą standartams).

Remiantis  LR  Vyriausybės  patvirtintais  Bendraisiais  reikalavimais  valstybės  institucijų  interneto 

1 Dėl Elektroninės valdžios koncepcijos patvirtinimo
http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184 

(Lietuvos Respublikos Vyriausybė/Nutarimas/2115/2002 12 31/Įsigaliojo nuo 2003 01 09/Valstybės žinios'2003 Nr.2-54)
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svetainėms2 (20 p.),  viešai  pateikiamus dokumentus Lietuvos valstybės institucijos privalo publikuoti  ir 

atviraisiais  formatais,  o  savivaldybėms  ir  Lietuvos  Respublikos  Vyriausybei  nepavaldžioms  valstybės 

įstaigoms bei institucijoms yra rekomenduojama vadovautis šiais reikalavimais.

Aukščiau minėtoje Elektroninės valdžios koncepcijoje, 7 skyriuje „Viešųjų paslaugų teikimo techniniai 

sprendimai“ taipogi akcentuojama atvirųjų formatų svarba:  „Informacijai teikti turi būti naudojami atvirieji 

formatai.  Institucijų taikomi  bendravimo protokolai  ir  formatai  neturi  versti  informacijos vartotojų  įsigyti 

mokamų operacinių sistemų ar programinės įrangos“.

Kauno miesto savivaldybės ir Kauno regiono plėtros agentūros rengtoje Kauno miesto „El. savivaldos 

koncepcijoje“3, skyriuje „Techniniai sprendimai“ rašoma, kad ir el. Savivaldoje turi būti naudojami atvirieji 

formatai:  „Lengvą prieinamumą prie e-Savivaldos teikiamos informacijos ir  paslaugų užtikrins tai,  kad 

sąsajai  su  naudotoju  bus  naudojamos  paplitusios  atvirosios  technologijos  bei  visuotinai  naudojami 

duomenų formatai, protokolai ir įrenginiai. Šios priemonės nevers informacijos naudotojų įsigyti mokamas 

operacines sistemas ar programinę įrangą“.

Kalbėdama apie  atvirąjį  dokumentų  mainų  formatą  (Open Document  Exchange Format),  Europos 

Komisijos  programa  IDABC  (Interoperable  Delivery  of  European  eGovernment  Services  to  public 

Administrations, Businesses and Citizens) pabrėžia, kad toks formatas panaikina priklausomybę produktui 

ar  technologijai,  užtikrina  sąveikumą  (angl.  -  interoperability)  keičiantis  dokumentais.  Informacijos 

pasikeitimas dokumentais yra labai svarbi veikla viešajame sektoriuje, todėl dokumentų sąveikumas yra 

pagrindinė savybė bet kurioje elektroninės valdžios strategijoje.4

1.2 Nuosavybinė (mokama) ir laisva atvirojo kodo programinė įranga 

LR Vyriausybės patvirtintoje Elektroninės valdžios koncepcijoje5 pabrėžiama, kad atvirųjų technologijų 

bei atvirųjų dokumentų formatų ir protokolų naudojimas nevers informacijos naudotojų įsigyti mokamas 

operacines sistemas ar programinę įrangą. Taigi, iškyla klausimas, kas yra mokama programinė įranga ir 

kokios yra jos alternatyvos. Mokama programinė įranga (dar vadinama nuosavybine programine įranga) – 

tai  vienam gamintojui  arba  uždarai  gamintojų  grupei  priklausanti  programinė  įranga,  kurios  negalima 

laisvai keisti, platinti bei pamatyti jos išeities tekstus be gamintojo(-ų) leidimo. Nepriklausomi gamintojai 

negali  sukurti  programinės  įrangos,  100%  suderinamos  su  nuosavybine,  nebent  nuosavybinės 

programinės įrangos pagrindinis duomenų išsaugojimo (mainų)  formatas yra atviras.  Jei  gyventojai  ar 

organizacijos  yra  priversti  naudotis  tik  vieno  gamintojo  ar  gamintojų  grupės  nuosavybine  programine 

įranga, tuomet dingsta konkurencija. Nuosavybinė programinė įranga gali būti ir nemokama, tačiau nėra 

jokios  garantijos,  kad  gamintojas  neapmokestins  jos  ateityje,  priešingai  nei  yra  laisvos  programinės 

įrangos atveju.

Už  laisvą programinę įrangą (Free Software)  taip  pat  galima imti  pinigus,  tačiau jos niekas negali 

uždrausti nemokamai platinti, nes bet kuris asmuo ar įmonė gali keisti, tobulinti, platinti perrašyti kolegai ar 

2 Dėl bendrųjų reikalavimų valstybės institucijų interneto svetainėms patvirtinimo
http://www3.lrs.lt/cgi-bin/preps2?Condition1=209540 

(Lietuvos Respublikos Vyriausybė/Nutarimas/480/2003 04 18/Įsigaliojo nuo 2003 04 25/Valstybės žinios'2003 Nr.38-1739)
3 www.krda.lt/krdalit/projektai.html   
4 http://europa.eu.int/idabc/en/document/3428   
5 Dėl Elektroninės valdžios koncepcijos patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184 
(Lietuvos Respublikos Vyriausybė/Nutarimas/2115/2002 12 31/Įsigaliojo nuo 2003 01 09/Valstybės žinios'2003 Nr.2-54)
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draugui laisvą programinę įrangą be gamintojo leidimo ir be jokio mokesčio gamintojui. Kadangi laisvos 

programinės įrangos išeities tekstai (programos kodas) yra laisvai prieinami ji dar yra vadinama atvirojo 

kodo programine įranga (Open Source Sofware). Europos Sąjungoje šalyse, Europos Komisijoje dažnai 

yra naudojamas ir Free (Libre) Open Source Software terminas.

Aukščiau minėtoje elektroninės valdžios koncepcijos pateikiami tokie sąvokų apibrėžimai: „Atvirasis 

kodas/atvirasis  tekstas –  laisvai  platinami  programų  tekstai  programavimo  kalba“,  „Atvirojo  kodo 

programinis produktas – sukurtas atvirojo kodo principu programinis produktas, kurį galima modifikuoti 

laikantis prie jo pridedamų arba jame nurodytų licencijų sąlygų“, „Mokamos programos/programinė įranga 

– programinė įranga, platinama tik už mokestį“.

Programinė įranga bus garantuotai nemokama tik tuo atveju, jei ji  yra laisva (jei ji  platinama pagal 

laisvas licencijas).

1.3 Lietuvos, Latvijos ir Europos Komisijos teisės aktų apžvalga

1.3.1 Lietuva

Kadangi šiame vartotojo vadove kalbama apie viešųjų paslaugų teikimą gyventojams ir įmonėms ir jų 

efektyvumą,  toliau  bus  apžvelgtas  standartų  ir  dokumentų  formatų  naudojimas,  apibrėžtas  Lietuvos 

Respublikos  teisės  aktuose,  kurie  reglamentuoja  elektroninę  valdžią,  elektronines  paslaugas, 

informacinės visuomenės plėtrą, viešąjį administravimą ir kt.

LR Vyriausybė yra parengta Informacinės visuomenės paslaugų įstatymo koncepciją6, siekiant apibrėžti 

ir įtvirtinti visuomeninių santykių, susijusių su informacinės visuomenės paslaugomis, teisinio reguliavimo 

pagrindus.  Koncepcija  parengta  įgyvendinant  Lietuvos  Respublikos  Vyriausybės  2001–2004  metų 

programos  įgyvendinimo  priemonių  66  punktą  ir  Elektroninės  valdžios  koncepcijos  įgyvendinimo 

priemonių plano  2.6 punktą.  Informacinės visuomenės plėtros strateginis tikslas – skatinti informacinės 

visuomenės plėtros procesą Lietuvoje, padėti gyventojams integruotis į pasaulio informacinę visuomenę, 

kuo geriau panaudoti jos teikiamas galimybes.

Visų  pirma,  pateiksime  informacinės  visuomenės  suvokimą,  kaip  jis  nusakomas  Informacinės 

visuomenės  paslaugų  įstatymo  koncepcijoje.  Informacinė  visuomenė –  tai  atvira,  išsilavinusi,  nuolat 

besimokanti ir žiniomis savo veiklą grindžianti visuomenė, kurios nariai – paprasti Lietuvos gyventojai ir 

visų lygių vadovai – gali, moka ir nori visose savo veiklos srityse efektyviai taikyti šiuolaikinių informacinių 

technologijų priemones, naudotis savo šalies ir viso pasaulio kompiuterizuotais informacijos ištekliais, o 

valstybės ir savivaldos institucijos, įstaigos, pasitelkdamos šias priemones ir išteklius, priimti sprendimus, 

užtikrinti gyventojams prieinamą ir patikimą viešąją informaciją.

Informacinės  visuomenės  paslaugos  –  paprastai  už  atlyginimą  elektroninėmis  priemonėmis  ir  per 

atstumą individualiu paslaugos gavėjo prašymu teikiamos paslaugos, įskaitant daiktų pardavimą pagal 

sutartis,  sudaromas  elektroninėmis  priemonėmis,  taip  pat  paslaugas,  kurios  jų  gavėjams  teikiamos 

neatlygintinai,  ir  informacijos paieškos paslaugas. Informacinės visuomenės paslaugos taip pat apima 

6 Dėl Lietuvos Respublikos informacinės visuomenės paslaugų įstatymo koncepcijos patvirtinimo
http://www3.lrs.lt/cgi-bin/preps2?Condition1=242991&Condition2= 

(Lietuvos Respublikos Vyriausybė/Nutarimas/1276/2004 10 11/Įsigaliojo nuo 2004 10 15/Valstybės žinios'2004 Nr.151-5497)
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viešojo administravimo funkcijų vykdymą elektroninėmis priemonėmis per atstumą individualiu asmens 

(pareiškėjo)  prašymu.  Informacinės  visuomenės  paslaugos  neapima  daiktų  pristatymo  paslaugų  ir 

elektroninių priemonių naudojimo (tokio kaip elektroninio pašto arba analogiškų individualių pranešimų 

naudojimas),  atliekamo fizinių asmenų tikslais, nesusijusiais su jų amatu,  verslu ar profesija, įskaitant 

sutarčių tarp tokių asmenų sudarymą.

Paslaugų teikėjas – fizinis ar juridinis asmuo, teikiantis informacinės visuomenės paslaugą. Paslaugų 

gavėjas – bet kuris fizinis ar juridinis asmuo, kuris profesiniais, verslo, asmeniniais, šeimos, namų ūkio ar 

kitais  tikslais  naudojasi  informacinės  visuomenės  paslauga,  ypač  norėdamas  ją  gauti  ar  padaryti 

prieinamą.

O kaip suprantama elektroninė viešoji paslauga. Elektroninė viešoji paslauga – tai paslauga, suteikianti 

asmeniui  galimybę  jo  buvimo  vietoje  skaitmeniniu  pavidalu  viešaisiais  kompiuterių  tinklais  atlikti  jo 

poreikius tenkinančias įvairias procedūras ir gauti informaciją. Elektronines paslaugas gali vartoti žmonės, 

verslas ir  jos  gali  būti  pasiekiamos įvairiais  informacijos įtaisais.  Dažniausiai  naudojamas elektroninių 

viešųjų paslaugų teikimo skirstymas į  etapus,  atspindinčius elektroninių viešųjų paslaugų teikimo lygį, 

apima šias fazes: informacija, interaktyvumas, dviejų krypčių interaktyvumas, tranzakcijos.7

- Pirmajame etape elektroniniu būdu tik pateikiama informacija (interneto svetainėje). 

- Antrajame  etape vartotojui  suteikiamos  jau  platesnės  galimybės –  pavyzdžiui,  jis  internetu  gali 

parsisiųsti  elektronines  formas,  tačiau  jas  užpildęs  turi  pateikti  tradiciniais  būdais:  paštu,  faksu, 

asmeniškai, pan. 

- Trečiajame etape elektroniniu būdu galima ne tik gauti, bet ir pateikti užpildytas paraiškas formas ir 

pan. 

- Ketvirtajame etape  jau atliekamas pilnas aptarnavimas internete, apimantis formų parsisiuntimą, 

pateikimą ir apmokėjimą.

Elektroninėje valdžios koncepcijoje8 vartojamos pagrindinės sąvokos: “Institucijų viešosios paslaugos – 

terminas „viešosios paslaugos“ šioje koncepcijoje vartojamas plačiąja prasme ir apima visą gyventojo ar 

verslo subjekto bendravimą (pvz.,  paklausimą ir  atsakymą į  paklausimą,  įvairių dokumentų pildymą ir 

pateikimą, atsiskaitymus ir kita)“, „Nuotoliniai viešųjų paslaugų teikimo būdai – šis terminas koncepcijoje 

apima  visas  viešųjų  paslaugų  teikimo  priemones,  leidžiančias  bendrauti,  paklausti  ir  gauti  viešąją 

paslaugą be tiesioginio ryšio tarp viešosios paslaugos teikėjo ir gavėjo“.

Elektroninės  valdžios  koncepcijoje  išdėstytas  požiūris  į  elektroninės  valdžios  reiškinius  Lietuvoje. 

Elektroninė valdžia sudaro elektroninės komercijos pagrindą, todėl minėtojoje koncepcijoje suformuluotų 

tikslų  ir  uždavinių  įgyvendinimas  sudarys  sąlygas  naudotis  ne  tik  elektroninės  valdžios  teikiamomis 

galimybėmis, bet ir sumažins elektroninės komercijos plėtros, taigi ir informacinės visuomenės paslaugų 

teikimo kliūtis. Pateikiamas toks e. valdžios projekto apibrėžimas: „E. valdžios projektas – projektas, kuris 

apima vienos institucijos ar bendrus kelių institucijų telekomunikacijų,  informacinių technologijų,  teisės 

aktų rengimo, vadybos ir kitus projektus ir kurio tikslas – perkelti viešųjų paslaugų teikimą į skaitmenines 

technologijas“.

7 www.ivpk.lt/main-aktual.php?cat=6&n=11   
8  http://www3.lrs.lt/cgi-bin/preps2?Condition1=222092 
(Lietuvos Respublikos Vyriausybė/Nutarimas/1468/2003 11 25/Įsigaliojo nuo 2003 11 29/Valstybės žinios'2003 Nr.112-5022)
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Įgyvendindama  Viešojo  administravimo  plėtros  iki  2010  metų  strategijos,  patvirtintos  Lietuvos 

Respublikos Vyriausybės 2004 m. balandžio 28 d. nutarimu Nr. 488 (Žin., 2004, Nr. 69-2399), 66 ir 68 

punktus,  Lietuvos Respublikos  Vyriausybė nutarimu patvirtino  Viešojo  administravimo plėtros iki  2010 

metų  strategijos  įgyvendinimo  2005–2006  metų  priemonių  planą9).  Šiuo  nutarimu  siekiama:  tobulinti 

viešojo administravimo sistemą bei regioninio valdymo institucijų vidinę sandarą ir jų veiklą, plėtoti vietos 

savivaldą (vietos  savivaldos  lygiu  sukurti  veiksmingą  valdymą,  patogų gyventojams),  didinti  valstybės 

tarnybos administracinius gebėjimus, gerinti valstybės tarnautojo įvaizdį, tobulinti viešojo administravimo 

institucijų teikiamų paslaugų prieinamumą, kokybę, skaidrumą ir  trumpinti  aptarnavimo trukmę plačiau 

naudojantis informacinių technologijų teikiamomis galimybėmis.

Trečiasis priemonių plane numatytas strateginis tikslas apima vietos savivaldos plėtrą, siekiant vietos 

savivaldos lygiu sukurti veiksmingą valdymą, patogų gyventojams. Vienas iš strateginio tikslo uždavinių 

yra sudaryti savivaldybėms sąlygas teikti gyventojams prieinamas geros kokybės viešąsias paslaugas. Tai 

įgyvendinti  numatyta  inicijuoti  viešųjų  paslaugų  teikimo  savivaldybėse  analizės  atlikimą,  išanalizuoti 

viešųjų paslaugų teikimo gyventojams savivaldybėse problemas ir numatyti priemones šioms problemoms 

spręsti, gerinti viešųjų paslaugų, teikiamų gyventojams savivaldybėse, kokybę. Už priemonių įgyvendinimą 

atsakinga Vidaus reikalų ministerija.

Vienas iš priemonių plane iškeltų uždavinių yra didinti  viešojo administravimo sprendimų priėmimo 

efektyvumą ir  skaidrumą (5.2.)  nustatant  elektroninių dokumentų valdymo ir  keitimosi  jais  valstybės ir 

savivaldybių  institucijose  bendruosius  reikalavimus,  sudarant  sąlygas  valstybės  ir  savivaldybių 

institucijoms  rengti,  siųsti  ir  saugoti  elektroninius  dokumentus.  Šis  vartotojas  ir  projekto  metu  atlikta 

Lietuvos  savivaldybių  svetainių  atitikimo  atviriesiems  standartams  bei  publikuojamų  dokumentų 

svetainėse analizė galėtų tapti gairėmis naujiems projektams. Už šios priemonės įgyvendinimą atsakingas 

Lietuvos archyvų departamentas ir Vidaus reikalų ministerija.

2005 metų IV ketvirtyje ketinama parengti teisės aktą, reglamentuojantį atvirųjų standartų naudojimą 

teikiant paslaugas gyventojams, valstybės institucijoms elektroninėmis priemonėmis keičiantis informacija, 

sudaryti  sąlygas keistis  tarpusavyje neiškraipyta informacija,  t.  y.  įteisinti  atvirųjų  standartų naudojimą 

atvirojoje  programinėje  įrangoje  (5.2.4.).  Už  šios  priemonės  įgyvendinimą  atsakingas  Informacinės 

visuomenės plėtros komitetas, Vidaus reikalų ministerija, Lietuvos archyvų departamentas.

2005-2006 metais planuojama vykdyti viešųjų paslaugų teikimo naudojant skaitmenines technologijas 

valstybės ir  savivaldybių institucijose ir  įstaigose priežiūrą:  sukurti  viešųjų paslaugų teikimo naudojant 

skaitmenines technologijas priežiūros metodiką; atlikti viešųjų paslaugų teikimo naudojant skaitmenines 

technologijas stebėseną. Ketinama pasiekti, kad visos viešojo administravimo paslaugos būtų perkeltos į 

elektroninę terpę,  kad viešųjų  paslaugų teikėjai  vienodai  nustatytų fizinių ir  juridinių asmenų tapatybę 

valstybės informacinėse sistemose, kad viešoji paslauga būtų suteikta tik tam asmeniui, kuris jos prašė. 

Už įgyvendinimą atsakinga Vidaus reikalų ministerija, Informacinės visuomenės plėtros komitetas.

2005–2006 metais taip pat planuojama nustatyti esamą valstybės tarnautojų e. gebėjimų lygį ir parengti 

bendrųjų  e.  gebėjimų  lavinimo  programą.  Tam  reikalinga  atlikti  viešųjų  paslaugų,  teikiamų  internetu, 

tyrimą.  Tikslas  -  atnaujinti  turimas  ir  parengti  naujas  valstybės  ir  savivaldybių  institucijų  valstybės 

tarnautojų  kvalifikacijos  tobulinimo  programas  e.  paslaugų  teikimo  gyventojams,  verslui  ir  viešajam 

9 http://www3.lrs.lt/cgi-bin/preps2?Condition1=250676   
 (Lietuvos Respublikos Vyriausybė/Nutarimas/197/2005 02 21/Įsigaliojo nuo 2005 02 25/Valstybės žinios'2005 Nr.26-830
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sektoriui srityse; kelti valstybės tarnautojų kvalifikaciją pagal atnaujintas ir parengtas naujas e. paslaugų 

teikimo  programas,  kad  gyventojai  gautų  vis  geresnes  e.  paslaugas  žinių  visuomenėje  ir  žinių 

ekonomikoje. Pagal parengtą programą bus vykdomi valstybės tarnautojų mokymai(5.3.12.). Atsakingos 

organizacijos:  Informacinės  visuomenės  plėtros  komitetas,  Lietuvos  viešojo  administravimo  lavinimo 

institucijų asociacija, Lietuvos savivaldybių asociacija.

Priemonių  planas  parengtas  atsižvelgiant  į  Lietuvos  Respublikos  Vyriausybės  priimtą  Viešojo 

administravimo plėtros iki 2010 metų strategiją10, kuria siekiama sukurti aplinką viešojo administravimo 

sistemos plėtrai. Atsižvelgiant į Europos ministrų, atsakingų už viešąjį administravimą, 2003 m. gruodžio 1 

d. Romoje patvirtintą Bendradarbiavimo viešojo administravimo srityje vidutinės trukmės 2004–2005 metų 

programą,  šios  Strategijos  įgyvendinimo  laikotarpiu  ypač  daug  dėmesio  bus  skiriama  šioms  sritims: 

geresniam valdymui (Better Regulation), žmogiškųjų išteklių valdymui (Human Resource Management), 

naujovėms  teikiant  viešąsias  paslaugas  (Innovative  Public  Services),  elektroninei  valdžiai  (toliau 

vadinama – e. valdžia) (e-Government).

Tikimasi, kad šios strategijos įgyvendinimas padės įtvirtinti perėmimu ir tęstinumu grindžiamą šalies 

socialinės ir ekonominės raidos politiką, modernizuoti ir racionalizuoti valstybės ir savivaldybių institucijų 

bei įstaigų struktūrą, planavimo, organizavimo ir koordinavimo ryšius, įtvirtinti patikimą veiklos kontrolės ir 

vidaus audito sistemą, užtikrinti optimalų įgaliojimų, kompetencijos ir atsakomybės paskirstymą centriniu, 

teritoriniu  ir  vietos  savivaldos  lygiais.  Tobulės  viešojo  administravimo  sprendimų  dėl  asmenų,  kurie 

kreipiasi į valstybės ir savivaldybių institucijas bei įstaigas, priėmimo procedūros, bus siekiama paprasčiau 

teisiškai reglamentuoti verslą, sukurti  profesionalią, stabilią valstybės tarnybą, gebančią tinkamai atlikti 

savo  funkcijas  Lietuvai  tapus  ES  valstybe  nare,  užtikrinti  gerą  viešųjų  paslaugų  kokybę.  Sparti 

informacinės visuomenės plėtra suteiks galimybes modernizuoti valstybės ir  savivaldybių institucijų bei 

įstaigų darbą, patį viešojo administravimo procesą, kad jis veiktų efektyviai, būtų atviras asmenims, kad 

būtų operatyviai reaguojama į sparčiai kintančias aplinkybes.

2003 metais Lietuvos Respublikos Vyriausybė priėmė  Bendruosius reikalavimus valstybės institucijų 

interneto svetainėms11.  Bendrųjų reikalavimų valstybės institucijų interneto svetainėms tikslas – sudaryti 

visuomenei  sąlygas  gauti  internetu  visą  viešą  informaciją  apie  valstybės  institucijas  ir  jų  funkcijas, 

suvienodinti  valstybės  institucijų  interneto  svetaines,  užtikrinti  jų  veiksmingumą,  jose  pateikiamos 

informacijos  aktualumą,  patikimumą,  paieškos  galimybes,  svetainių  kūrimą  ir  reguliarų  informacijos 

atnaujinimą.  Šio  nutarimo  20  p.  sakoma:  „Valstybės  institucijų  interneto  svetainėse  siūloma  laikytis 

Pasaulinio interneto tinklo konsorciumo rekomendacijų,  apibrėžiančių interneto tinklalapių modeliavimo 

kalbų  naudojimą  (rekomendacijos  skelbiamos  tinklalapyje  http://www.w3.org/TR).  Valstybės  institucijų 

interneto  svetainių  peržiūrai  negali  būti  reikalaujama  specialios  komercinės  programinės  įrangos. 

Dokumentai tinklalapiuose turi būti prieinami naudojant ir atviruosius (aprašytus) duomenų failų formatus 

(HTML,  PDF  ir  kita).  Rekomenduojama  tinklalapius  pritaikyti  WAP  duomenų  perdavimo  protokolą 

palaikantiems bevieliams įrenginiams.“

Bendraisiais  reikalavimais  rekomenduojama vadovautis  ir  savivaldybėms bei  Lietuvos  Respublikos 

Vyriausybei nepavaldžioms valstybės įstaigoms bei institucijoms.

10 http://www3.lrs.lt/cgi-bin/preps2?Condition1=232235   
(Lietuvos Respublikos Vyriausybė/Nutarimas/488/2004 04 28/Įsigaliojo nuo 2004 05 01/Valstybės žinios'2004 Nr.69-2399)
11  http://www3.lrs.lt/cgi-bin/preps2?Condition1=209540 
 (Lietuvos Respublikos Vyriausybė/Nutarimas/480/2003 04 18/Įsigaliojo nuo 2003 04 25/Valstybės žinios'2003 Nr.38-1739)
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1.3.2 Latvija

Latvijos Respublikos Vyriausybė taip pat yra parengusi ir patvirtinusi teisės aktus, reglamentuojančius 

elektroninių  paslaugų  teikimą,  viešąjį  administravimą,  elektroninę  valdžią,  informacinės  visuomenės, 

elektroninių paslaugų, elektroninio parašo ir kitus klausimus. Tačiau juose nekalbama apie standartus, 

sąveikumą (angl. interoperability), suderinamas sistemas, dokumentų formatus. Visos Latvijos valstybinės 

institucijos  yra  visiškai  priklausomos  nuo  vieno,  rinkoje  stipriai  dominuojančio  programinės  įrangos 

gamintojo.

1.3.3 Europos Komisija

Europos  Komisija  skatina  naudoti  atviruosius  standartus,  užtikrinant  sistemų  sąveikumą  (angl. 

interoperability).  IDABC (Interoperable  Delivery  of  European  eGovernment  Services  to  public 

Administrations, Businesses and Citizens) yra Europos Komisijos programa, skatinanti atvirųjų standartų 

naudojimą viešajame sektoriuje12.

IDABC programos pagrindiniai tikslai:

- skatinti  ir  remti  visos  Europos  elektroninės  valdžios  viešųjų  paslaugų  teikimą  viešojo 

administravimo institucijoms, gyventojams ir verslo subjektams,

- pagerinti Europos viešojo administravimo institucijų veiksmingumą ir tarpusavio bendradarbiavimą,

- siekti, kad Europa taptų patrauklia vieta gyventi, dirbti ir investuoti. 

Europos Komisijos IDABC programos iniciatyvos:

- 2003  m.  birželyje  įvyko  pirmoji  aukšto  lygio  diskusija  apie  duomenų  mainų  formatus  TAC 

(Telematics between Administrations Committee) susitikime,

- 2003 m. rugsėjo mėnesį atlikta atvirųjų dokumentų standartų palyginamoji analizė. Įvertinta rinka ir 

vystomi atvirieji dokumentų formatai. Kompanijos „Microsoft“ (nuo 2003 metų savo biuro pakete „MS 

Office“ įdiegusi XML pagrindu sukurto WordML formato palaikymą) ir SUN (nuo 2001 metų savo biuro 

pakete  „StarOffice“  įdiegusi  XML pagrindu  sukurto  „OpenOffice.org  1.0“  formato  palaikymą)  buvo 

pakviestos pakomentuoti atliktąją analizę. Susitikime dalyvavo IDA (dabar – IDABC) ekspertai,

- 2004 m. gegužę TAC parengė keletą rekomendacijų dėl atvirųjų  dokumentų formatų naudojimo 

viešajame administravime. Rekomendacijose pabrėžiama, kad viešasis sektorius vengtų dokumentų 

formatų, kurie neužtikrina lygių galimybių rinkos dalyviams diegiant ar naudojant programas,

- EK direktoratas DG ENTR paskatino didžiuosius programinės įrangos gamintojus didinti dokumentų 

formatų sąveiką (angl. interoperability). Tai paskatino IBM, „Microsoft“ ir SUN imtis veiksmų šia linkme,

- 2004 m. lapkričio mėnesį didžiųjų rinkos žaidėjų palaikoma organizacija Open Forum Europe (OFE) 

pasiūlė  Europos  Komisijai  atvirojo  dokumento formato (Open Document  Format13)  iniciatyvą.  OFE 

rekomenduoja programinės įrangos gamintojams ir valstybių narių viešojo administravimo institucijoms 

naudoti šį dokumento formato viešiesiems dokumentams ir toliau jį vystyti,

- 2005 m. gegužės 1 d. tarptautinė organizacija OASIS standartizavo OpenDocument,

- Iki  2005  m.  pabaigos  tikimasi  OpenDocument formatą  standartizuoti  tarptautinėje  standartų 

organizacijoje ISO.

12 http://europa.eu.int/idabc   
13 http://europa.eu.int/idabc/en/document/3428   
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Vienas svarbiausių Europos Sąjungos šalims dokumentų yra Europos veiksmų planas 200514. Jame 

yra  sakoma:  “sukurti  sąveikumo  (interoperabilumo)  pagrindą  Europos  e-valdžios  paslaugų  teikimui 

gyventojams  ir  įmonėms.  Tai  apima  informacijos  turinį  ir  rekomenduojamas  technines  specifikacijas, 

siekiant  apjungti  visos Europos viešojo administravimo institucijų  informacines sistemas.  Sistema bus 

pagrįsta atviraisiais standartais ir skatins atvirojo kodo programinės įrangos naudojimą”. (eEurope Action 

Plan  2005):  “issue  an  agreed  interoperability  framework  to  support  the  delivery  of  pan-European e-

government  services  to  citizens  and enterprises.  It  will  address  information content  and  recommend 

technical policies and specifications for joining up public administration information systems across the 

EU. It will be based on open standards and encourage the use of open source software.”)

1.4 Kitų šalių patirtis

Šiame  skyrelyje  trumpai  apžvelgiamos  pastarojo  meto  veiklos  ir  iniciatyvos  naudojant  atviruosius 

formatus kitose ES šalyse.

2004 m. spalio 7 d. Belgijos informacinių technologijų administracija publikavo rekomendacijas dėl 

atvirųjų standartų ir atvirųjų specifikacijų naudojimo perkant programinę įrangą viešajam sektoriui. Pagal 

šias direktyvas atvirųjų standartų naudojimas yra privalomas visai naujai perkamai programinei įrangai, o 

egzistuojanti programinė įranga ilgainiui turėtų migruoti. 

2004 m. gruodžio 21 d. Danijos Naestved miesto savivaldybėje „OpenOffice.org“ paketas naudojamas 

daugiau nei metus. Pagrindinė priežastis pasirinkti  laisvą (atvirojo kodo) programinę įrangą buvo lėšų 

taupymas.

2005  m.  sausio  21  d.  Prancūzijos  žandarmerija  nusprendė  80  000  darbo  vietų  kompiuterių  biuro 

programų paketą „MS Office“ pakeisti į laisvą „OpenOffice.org“ programinę įrangą. Planuojama sutaupyti 

apie 2 milijonus eurų per metus.

2005 m. balandžio 18 d. Suomijos teisingumo ministerija renkasi atviruosius formatus bei standartus. 

Iš 10 000 kompiuterių į 8 500 rekomenduojama diegti „OpenOffice.org“. Ši programinė įranga pasirinkta 

dėl atvirojo OpenDocument formato palaikymo.

2005 m. balandžio 26 d. Miuncheno miesto taryba pasirinko atvirojo kodo programų tiekėjus, kurie 

diegs  programas  savivaldybės  14  tūkst.  kompiuterių  darbo  vietose.  Miesto  taryba,  įgyvendindama 

”LiMux”15 iniciatyvą, nuo „MS Windows” migruos prie „Linux” operacinės sistemos. Pagal kontraktą bus 

sukurta ir specializuotų programų. Migravimo projektą tikimasi baigti 2008-aisiais.

14 http://europa.eu.int/information_society/eeurope/2002/news_library/documents/eeurope2005/eeurope2005_en.pdf   
15 http://www.muenchen.de/Rathaus/referate/dir/limux/89256/   
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2 Atvirieji standartai Interneto svetainėse

Šioje vartotojo vadovo dalyje jūs galite susipažinti su Internete galiojančiais atviraisiais standartais, jų 

svarba ir taikymu. Ši dalis skirta ne tik informacinių sistemų personalui, bet ir priimantiems  sprendimus, 

susijusius su informacinių technologijų infrastruktūros strategija ir plėtra. Pagrindinius toliau naudojamų 

sąvokų apibrėžimus rasite 1 vartotojo vadovo dalyje.

2.1 Atvirieji standartai Internete

Ekonominis atvirųjų standartų naudojimo efektas yra toks, kad jie sukuria sąžiningą, konkurencingą 

aplinką, skatina konkurenciją tarp tiekėjų ir tokiu būdu sudaro geresnes sąlygas naudotojui.

Atvirieji  standartai,  aprašantys  Interneto  technologijas,  lėmė  Interneto  populiarumą  ir  leido  šioms 

technologijoms nugalėti konkuruojančias nuosavybines technologijas. Tik šių technologijų atvirumas leido 

atsirasti  globaliai  techninių,  programinių  priemonių  bei  paslaugų  rinkai.  Iki  tol  egzistavę  informaciniai 

kompiuterių tinklai arba perėjo prie Interneto technologijų (MSN, AOL), arba išnyko (CompuServe).

Atvirųjų  standartų  dominavimas  leidžia  naudotojui  laisvai  rinktis  elektroninio  pašto  serverius, 

elektroninio  pašto  programas,  žiniatinklio  serverius,  naršykles  ir  beveik  nesirūpinti  suderinamumo 

klausimais. Taigi, naudojamų standartų atvirumas yra Interneto esminė savybė, ir jos naudojimas padės 

pasinaudoti veiksniais, kurie lėmė Interneto populiarumą. 

2.2 Žiniatinklio istorija ir atvirieji standartai

HTML ir HTTP technologijos atsirado ankstyvaisiais 1990-aisiais neformalių specifikacijų pavidalu. Šios 

specifikacijos buvo standartizuotos tuo tikslu susikūrusios organizacijos W3C, kuri 1995 metais išleido 

HTML 2.0  standartą.  Standarte buvo pabrėžiama HTML kaip  teksto  struktūros  žymėjimo kalbos rolė. 

Dokumento išvaizdos aprašymo savybės buvo gana ribotos šiandienos požiūriu.

Prasidėjo  taip  vadinami  „naršyklių  karai“.  „Netscape“  ir  „Microsoft“  kompanijos,  siekdamos 

diferencijuoti savo produktus, į juos ėmė dėti su standartais nesusijusių savybių. Dažniausiai tos savybės 

buvo skirtos vizualių Interneto puslapių savybių žymėjimui. Dėl šios priežasties vienai naršyklei sukurtas 

puslapis buvo visai kitaip rodomas kitų naršyklių. Siekiant išspręsti atsiradusius nesuderinamumus buvo 

išleista HTML 3.2 versija, įteisinusi daugelį tuo metu praktiškai naudotų vizualaus formatavimo priemonių.

Šiuo metu aktualūs standartai HTML 4.01 ir XHTML 1.1 vėl pabrėžia dokumento struktūros žymėjimą, 

bet leidžia kurti išvaizdžius puslapius HTML dokumentą papildant CSS formato stiliaus schema.

2.3 Kodėl verta laikytis standartų?

Savivaldybių Interneto svetainių svarbiausia funkcija – informacijos sklaida, viešųjų paslaugų teikimas, 

todėl viena svarbiausių jų savybių yra sąveikumas (angl.  interoperability). Kitais žodžiais tariant, svarbu, 

kad šios svetainės būtų prieinamos kuo platesniam naudotojų ratui: gyventojams, įmonėms, taip pat – 

keičiantis informacija su kitomis institucijomis. Atvirųjų standartų laikymasis užtikrina, kad svetainė bus 

pasiekiama žmonėms su negalia, besinaudojantiems tekstinėmis naršyklėmis su kalbos generatoriais ar 
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Brailio terminalais. Be to, atvirųjų standartų laikymasis leidžia pasiekti, kad svetainėje esanti informacija 

būtų  lengvai  prieinama  per  šiuolaikinius  mobiliuosius  telefonus  ir  kitokius  mobilius  įrenginius, 

indeksuojama  Interneto  paieškos  sistemų,  prieinama  automatizuotoms  priemonėms,  naudojančioms 

svetainėje pateiktą informaciją.

 Atvirųjų standartų laikymasis suteikia lygias teises visiems naudotojams, nes nesusieja su konkrečiu 

gamintoju.  Be  to,  standartų  besilaikanti  svetainė  veiks  su  ateityje  pasirodysiančiomis  naršyklėmis,  o 

šiuolaikinių  naršyklių  nestandartines  savybes  naudojančias  svetaines  ateityje  gali  tekti  perdaryti. 

Technologijų kaita Internete yra labai greita, taigi tokių pataisymų gali prireikti vos po keleto mėnesių.

2.4 Lietuvos savivaldybių svetainių atitikimo atviriesiems standartams 
testavimo rezultatai

Įgyvendinant atvirųjų duomenų mainų standartų pilotinį projektą, 2005 m. vasario mėnesį buvo atliktas 

Lietuvos ir Latvijos svetainių testavimas, siekiant išsiaiškinti atitikimą standartams.

Iš 60 testuotų Lietuvos savivaldybių svetainių tik vienos (http://www.prienai.lt/) kai kurios dalys atitiko 

HTML ir CSS standartus, dar 6 svetainės atitiko CSS standartus, nors neatitiko HTML standartų.  Likusios 

naudojo  standartų  neatitinkantį  HTML  kodą.  Reiktų  pastebėti,  kad  kritinės  klaidos  visgi  nesudaro 

daugumos.

Iš 30 testuotų Latvijos savivaldybių svetainių, HTML standartų neatitiko nei viena, tik  7 atitiko CSS 

standartus, bei dar 13 atitiko CSS standartus, bet sulaukė tikrintuvo perspėjimų.

Šie  rezultatai  kelia  nerimą,  nes  dauguma  testuotų  svetainių  buvo  sukurtos  Interneto  svetaines 

kuriančių  įmonių  pagal  užsakymą.  Tai  reiškia,  kad  paslaugos  tiekėjai  suteikė  nekokybišką  paslaugą. 

Savivaldybių informacinių sistemų padalinių darbuotojai, užsakydami paslaugą, turėtų numatyti atitikimą 

standartams  jau  techninėse  užduotyse,  o  įgyvendinant  –  reikalauti  atitikimo  standartams  iš  Interneto 

svetainių kūrėjų.

3 Svetainės atitikimo atviriesiems standartams testavimas ir 
taisymas

Šis skyrius yra skirtas interneto svetainių kūrėjams bei  savivaldybių informacinių sistemų padalinių 

darbuotojams, atsakingiems už Interneto svetaines. Šios dalies tikslas – suteikti informacijos, kaip sukurti 

ir palaikyti standartus atitinkančią interneto svetainę. Šioje dalyje daroma prielaida, kad skaitytojas yra 

susipažinęs su HTML ir CSS pagrindais.

3.1 Bendros sąvokos

HTML (HyperText Markup Language) – hiperteksto dokumentų aprašymo kalba. HTML yra vienas iš 

svarbiausių žiniatinklio atvirųjų standartų.
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XHTML (The Extensible HyperText Markup Language) tai HTML kalbos variantas, pagrįstas atitikimu 

XML kalbos reikalavimams. XHTML dokumentus galima apdoroti daugybe egzistuojančių įrankių, skirtų 

darbui su duomenimis XML formatu. Iš XHTML pašalintos nereikalingos HTML dalys, įdiegtas papildomas 

funkcionalumas (tobulesnis formų veikimas).

XML (Extensible Markup Language) – išplečiama dokumentų aprašymo kalba. XML – tai formatas, 

leidžiantis struktūrizuotu tekstiniu pavidalu aprašyti duomenis.

CSS (Cascading  Style  Sheets)  –  pakopinių  stilių  schemos.  CSS  leidžia  tiksliai  aprašyti  HTML 

dokumentų išvaizdą bei išdėstymą.

Svetainė, tinklapis – vienai temai skirti, turintys bendrą temą HTML dokumentai.

WWW (World Wide Web) – žiniatinklis, hiperteksto dokumentų sistema internete.

W3C (World Wide Web Consortium) – tarptautinė organizacija, kurianti WWW standartus16.

3.2 HTML standartų istorija

Nuo HTML specifikacijų kūrimo pradžios buvo išleisti šie HTML kalbos standartai:

- HTML 2.0 (http://www.ietf.org/rfc/rfc1866.txt) — (RFC 1866) 1995-09-22 

- HTML 3.2 (http://www.w3.org/TR/REC-html32) — 1997-01-14

- HTML 4.0 (http://www.w3.org/TR/REC-html40-971218/) — 1997-12-18 

- HTML 4.01 (http://www.w3.org/TR/html401) — 1999-12-24

HTML 1.0 neturi oficialios specifikacijos. Kuomet jis buvo sukurtas, buvo keletas neformalių HTML 

standartų. 1993 m. buvo pradėtas vieno bendro standarto kūrimas. Sukurta kalba buvo pavadinta HTML 

2.0, norint atskirti ją nuo neoficialių „standartų“.

HTML 3.0 buvo pasiūlytas kaip standartas 1995 m. kovą įkurtos W3C organizacijos. HTML 3.0 siūlė 

daugybę  naujovių,  pavyzdžiui,  lentelės,  automatiškai  apgaubiantis  objektus  tekstas,  sudėtingų 

matematinių  objektų  atvaizdavimas.  Tačiau  HTML  3.0  buvo  per  sudėtingas,  jo  nepalaikė  to  meto 

naršyklės. HTML 3.1 niekada nebuvo oficialiai pasiūlytas kaip standartas. Standartu tapo kompromisinis 

HTML 3.2,  atsisakęs  daug  naujovių  ir  apėmęs  daugelį  naršyklėms  „Netscape“  ir  „Mosaic“  specifinių 

elementų.  HTML 3.0  siūlytas  matematinių  simbolių  palaikymas  buvo  integruotas  atskirame  standarte 

MathML (http://www.w3.org/Math/).

Į HTML 4.0 taip pat buvo įtraukta naršyklėms specifinių elementų, tačiau buvo nutarta išgryninti HTML 

kaip standartą ir dauguma šių elementų tapo nerekomenduojamais.

Šiandien  situacija  yra  tokia,  daugiau  HTML standarto  versijų  nebus  kuriama,  nes  šiuo  metu  yra 

tobulinama XHTML kalba, kuri yra paremta XML formatu.

3.3 Keturi HTML elementų tipai

HTML dokumentus sudarantys elementai gali būti išskirti į šias grupes:

1. Struktūriniai  elementai.  Nusako  teksto  paskirtį.  Pavyzdžiui  antraštė  (angl. 

heading)<h1>Sveiki</h1>.

2. Prezentaciniai elementai. Nusako teksto išvaizdą, neatsižvelgiant į teksto paskirtį. Pavyzdžiui, 

16 http://www.w3c.org   
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pusjuodis tekstas (angl. bold), žymimas taip: <b>tekstas</b>. Dabar siūloma prezentacinių 

elementų atsisakyti ir naudoti CSS.

3. Nuorodos. Aprašo nuorodas į kitą dokumentą. Pavyzdžiui, žymė

       <a href=“http://www.w3c.org“>W3C</a> 

sukurs tekstą „W3C“, kurį spragtelėjus naršyklė bus nukreipiama į www.w3c.org tinklalapį.

4. Specialieji elementai. Aprašo įvairius objektus, pavyzdžiui, mygtukus bei sąrašus.

3.4 Stilius ir turinys

Dabartinės HTML versijos siūlo atsisakyti prezentacinių elementų naudojimo. HTML dokumente 

turėtų  būti  žymima  tik  struktūra,  o  išvaizda  nurodoma  naudojant  CSS.  HTML 4.01  Strict  ir  XHTML 

specifikacijose panaikintos <font>, <b>, <i> žymės.

Visą  prezentaciją  palikus  CSS,  o  HTML  naudojant  tik  struktūrai  aprašyti,  svetainė  atitiks 

standartus be papildomų pastangų, nes nebus naudojama neleistinų žymių bei atributų.

3.5 Pagrindinės svetainės kūrimo taisyklės

3.5.1 HTML pagrindai

HTML  dokumentą  sudaro  tekstas,  suskirstytas  žymėmis.  Žymės  (angl.  tag),  kitaip  vadinamos 

elementais,  išskiriamos  simboliais  „<“  ir  „>“.  Žymės  nurodo  jomis  išskirto  teksto  paskirtį  dokumento 

struktūroje.  HTML dokumentą  sudaro  dokumento  tipas,  antraštė  ir  turinys,  o  dokumento  struktūros 

pavyzdį matote 1 paveikslėlyje:

Dokumento tipas. Pirmoji žymė pavyzdyje 1 nurodo HTML dokumento tipą. Dokumento tipas nurodo, 

kokias  dokumento  apdorojimo  taisykles  turėtų  naudoti  naršyklė.  Dokumento  tipo  praleidimas  –  labai 

dažna klaida. Jei jūsų HTML dokumente jo trūksta – įrašykite jį. Jei naudojate XHTML dokumento tipą, šis 

sakinys atrodys taip:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN">.

Galiojančių dokumentų tipų sąrašą galite rasti adresu http://www.w3.org/QA/2002/04/valid-dtd-list.html.

Kiekvienas HTML dokumentas prasideda žyme <html> ir baigiasi žyme</html>.
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<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">

<html>
<head>

<title>Dokumento pavadinimas</title>
<meta http-equiv="Content-Type" 
      content="text/html; charset=windows-1257">

</head>

<body>
<!-- Dokumento turinys -->

</body>
</html>

1 pav. HTML dokumento struktūra.
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Antraštė. Antraštėje tarp žymių <head></head> nurodomas dokumento pavadinimas, koduotė, CSS 

stilius, aprašymas, raktiniai žodžiai paieškos sistemoms, JavaScript scenarijai (rekomenduojame jų vengti 

arba naudoti tik paprastiems dalykams).

HTML specifikacija reikalauja nurodyti dokumento pavadinimą. Jis turi tiksliai nusakyti turinį, bet nebūti 

per ilgas. Dokumento pavadinimas rašomas taip:  <title>Dokumento pavadinimas</title>. Šis 

pavadinimas bus matomas naršyklės lango antraštėje.

Antra  labai  dažnai  pasitaikanti  klaida  –  nenurodyta  dokumento  koduotė.  Koduotę  nurodyti  būtina! 

Koduotė parodo,  kokios kalbos simbolius mes naudosime ir  kokiu būdu jie  užkoduoti.  Lietuvių kalbai 

naudojame Windows-1257 arba ISO-8859-13 koduotę. Jei norime viename dokumente naudoti kelių 

kalbų simbolius, naudojame universalią UTF-8 koduotę.

Turinys. Tarp <body></body> žymių rašomas dokumento turinys.

3.5.2 Dažnai pasitaikančios HTML klaidos

- Viena dažniausiai pasitaikančių klaidų – nenurodytas dokumento tipas. Jei jūsų HTML dokumente 

jo  trūksta  –  įrašykite  jį.  Jei  naudojate  XHTML  dokumento  tipą,  šis  sakinys  atrodys  taip: 

<!DOCTYPE  html  PUBLIC  "-//W3C//DTD  XHTML  1.0  Transitional//EN">. 

Galiojančių  dokumentų  tipų  sąrašą  galite  rasti  adresu  http://www.w3.org/QA/2002/04/valid-dtd-

list.html.

- Kita gana dažna klaida – nenurodyta koduotė. Koduotę nurodyti būtina! Koduotė parodo, kokios 

kalbos simbolius mes naudosime ir kokiu būdu jie užkoduoti. 

- <img> žymėje  praleistas  alt=”” atributas. Šiuolaikinio  dizaino  puslapiuose  dažnai  sunku 

apsieiti be paveikslėlių, tačiau kai kurios naršyklės yra tekstinės, todėl jų atvaizduoti negali. Dėl 

šios priežasties W3C standartai reikalauja alt=”” atributo, kuriame įrašomas tekstas,  rodomas 

vietoje paveikslėlio; jei paveikslėlis nesvarbus, alt=””  atributą galime palikti tuščią.

- Lentelėse  naudojamas  atributas  height=””,  nors  W3C  standartuose  toks  lentelių  atributas 

neaprašytas. Kaip alternatyvą galima naudoti CSS height: ; atributą.

- HTML kalboje  & yra specialusis simbolis, naudojamas kitiems simboliams užrašyti naudojant jų 

simbolinius pavadinimus arba kodus. Pavyzdžiui, vienguba kabutė gali būti užrašyta kaip &quot;, 

o raidė „A“ gali būti užrašoma kaip &#65;. Labai dažnai pasitaiko programuotojų klaida, kai PHP 

ar kituose scenarijuose generuojamos nuorodos, kuriose naudojamas nepakeistas “&” simbolis. 

Jis turėtų būti keičiamas simbolių seka &amp;.

- Naudojant XHTML neretai pamirštama uždaryti pavienes žymes; teisinga paveiksliuko žymė turėtų 

atrodyti taip: <img src=”” width=”” height=”” alt=”” />.

- „Macromedia  Flash“  sugeneruotas  HTML kodas  neatitinka  W3C  standartų,  todėl  naudodami 

„Flash“  savo tinklapyje gausite daugybę klaidų. Siūlome atsisakyti  Flash arba jį  naudoti  tik  jei 

sugebate  sutvarkyti  „Flash“  sugeneruotą  kodą.  Apie  tai  daugiau  informacijos  rasite  adresu 

http://www.alistapart.com/articles/flashsatay/.

3.6 Svetainių testavimo atitikimo standartams procedūros 
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HTML atitikimą standartams galima patikrinti laisvai prieinamu HTML tikrintuvu, kurio adresas internete 

yra  http://validator.w3.org/.  Taip pat turėtumėte patikrinti  ir  CSS taisyklingumą (jei naudojate CSS). Tai 

galite atlikti šiuo adresu: http://jigsaw.w3.org/css-validator/. 

Toliau pažingsniui atliksime tikrinimo procedūrą.

1 žingsnis. Pasileidę naršyklę adreso laike įvedame http://validator.w3.org/. Tikrinimo aplinkoje turime 

du pasirinkimus: tikrinti svetainę nurodytu adresu (Validate by URL) arba tikrinti HTML dokumentą, esantį 

Jūsų kompiuteryje (Validate by File Upload).  Kaip pavyzdį  patikrinsime Alytaus savivaldybės svetainę. 

Suvedame svetainės adresą (http://www.alytus.lt) į laukelį Validate by URL ir spaudžiame „Check“:

2 pav. Pradinis tikrinimo langas

2 žingsnis. Pateikiama informacija apie tikrintą dokumentą. Antraštėje nurodytas dokumento tipas, 

koduotė, kiek yra neatitikimo specifikacijoms klaidų (3 pav.).

3 pav. Tikrinimo rezultato antraštė
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3 žingsnis. Žemiau matome išvardintas visas klaidas. Nurodoma, kurioje eilutėje rasta klaida ir šalia 

kiekvienos klaidos pateikiamas trumpas jos paaiškinimas (4 pav.).

CSS tikrinimas analogiškas, todėl jo neaprašinėsime. Tiesiog pirmame tikrinimo žingsnyje naršyklėje 

įveskite adresą http://jigsaw.w3.org/css-validator/. Paminėsime tik tai, jog CSS tikrinime yra papildoma 

funkcija, leidžianti tikrinti CSS kodą tiesiogiai įrašant jį į formą (Validate by direct input).

W3C yra sukūrusi paveikslėlių, rodančių svetainės atitikimą standartams, Jūs juos turbūt jau esate 

matę (pav. 5 ir 6).

Šie paveikslėliai dedami į Interneto svetainę, norint parodyti, jog svetainė kuriama remiantis 

standartais. Kai ištaisysite visas savo svetainės klaidas, http://www.w3.org ir Jums pasiūlys įdėti tokius 

paveikslėlius.

3.7 Sukurtos svetainės taisymas atitikimui standartams užtikrinti

Pagal  aukščiau  aprašytą  pavyzdį  atliekame  tikrinimą  (šį  kartą  tikrinsime  savo  dokumentą,  t.y. 
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naudosime  Validate  by  File  Upload).  Spragtelime  „Browse“, išsirenkame  savo  dokumentą,  tada 

spaudžiame „Check“.

Toliau  viskas  vyksta  pagal  aukščiau  esantį  aprašymą.  W3C  tikrinimo  paslauga  trumpai  paaiškins 

kiekvieną klaidą bei parodys eilutės, kurioje ji yra, numerį. Taip galėsite atsidarę svetainę savo mėgiamoje 

teksto rengyklėje nesunkiai surasti bei ištaisyti klaidas.  

Geriausias patarimas svetainės kūrimo metu – kiekvieną kartą pridėjus ar pakeitus elementą tikrinti 

puslapį http://validator.w3.org/. Taip taupysite savo laiką bei sukurta svetainė be papildomų rūpesčių atitiks 

standartus.

Šiame  skyriuje  aprašyti  metodai  netinka  taisyti  serverio  dinamiškai  generuojamiems  puslapiams, 

sukurtiems PHP, SSI, ASP, JSP ar panašiomis priemonėmis. Tokie puslapiai nesaugomi serveryje tuo 

pavidalu,  kuriuo  pateikiami  naudotojams,  tačiau  kaskart  sukonstruojami  įterpiant  puslapio  turinio 

elementus į HTML dokumento šabloną. Norint pasiekti tokių generuotų dokumentų atitikimą standartams, 

reikia redaguoti šabloną bei užtikrinti, kad jame talpinamos dalys taip pat atitinka HTML specifikacijas. 

Deja,  negalime pateikti  konkrečių instrukcijų,  kaip tai  daroma, nes taisymo būdas labai  priklauso nuo 

serveryje naudojamos programinės įrangos. Visgi visi šiame vadove pateikti principai pritaikomi ir tokioms 

svetainėms.

3.7.1 Tinklalapio redagavimas programa „Nvu“

Jei savo svetainei kurti ieškote grafinio įrankio ir nenorite rašyti HTML kodo, rekomenduojame HTML 

rengyklę „Nvu“ (http://www.nvu.com). Jos generuojamas kodas atitinka HTML specifikacijas, taigi nereikia 

taisyti kodo rankiniu būdu. Jei jūsų serveris palaiko WebDAV ar FTP protokolus, savo svetainę galėsite 

redaguoti tiesiogiai, atsisiųsdami iš jos dokumentus, pataisydami ir publikuodami.

„Nvu“ leidžia kurti dokumentus tiek grafiniame režime (WYSIWIG), tiek redaguojant HTML kodą. Jos 

bendras vaizdas parodytas 7 pav. Kairėje lango pusėje matote svetainių tvarkyklę, kurioje galite pasirinkti 

tinklalapį ar projektą, o dešinėje pusėje yra redaguojamo dokumento langas. Pasirenkant lango apačioje 

esančias korteles galima pasirinkti vieną iš dokumento vaizdų: įprasto redagavimo, redagavimo rodant 

žymes (pavaizduotas 7 pav.), HTML kodo redagavimo bei tinklalapio peržiūros.
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Jei naudojate paprastas HTML bylas bei jūsų serveris palaiko WebDAV protokolą, „Nvu“ programa 

galite įsikelti savo tinklalapį, pateikti jį HTML tikrintuvui ir išsaugoti rezultatą savo svetainėje. Norėdami tai 

padaryti, išsirinkite File→Open Web Location... meniu punktą ir įrašykite taisomo tinklalapio adresą. Tada 

pasirinkite Tools→Validate HTML. Dokumentas bus pateiktas HTML tikrintuvui. Gavę tikrinimo rezultatus 

atsiverskite HTML kodo kortelę (Source), suraskite klaidingas eilutes ir jas pataisykite. Tikrinimo rezultatus 

matysite atskirame lange, taigi galėsite pataisyti surastas klaidas (8 pav.)
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Pataisytą puslapį galite išsiųsti į serverį pasirinkę File→Publish meniu punktą. Programa jūsų paprašys 

įvesti savo naudotojo vardą ir slaptažodį rašymo prieigai serveryje. Publikavę puslapį galite jį vėl pateikti 

HTML tikrintuvui, kad įsitikintumėte, jog visos klaidos pataisytos.

3.7.2 Tinklalapio redagavimas programa „Mozilla Composer“

„Mozilla  Composer“  lange  pasirinkite  meniu  punktą  View→HTML  Source,  suraskite  netinkamai 

sugeneruotą  eilutę  ir  pagal  pateiktą  klaidos  diagnozę  ištaisykite.  Norėdami  matyti  įprastą  grafinį 

dokumento vaizdą, pasirinkite View→Normal Edit Mode.

Kuriant svetaines šia HTML rengykle rankinių kodo pakeitimų nereikės daryti, nes jos generuojamas 

HTML kodas atitinka standartus.

3.7.3 Tinklalapio redagavimas programa „FrontPage“

„Microsoft  FrontPage“  programoje  pasirinkite  View→HTML meniu  punktą.  Atsidariusiame  lange 

suraskite netinkamą eilutę ir ją pataisykite.
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Šiuo įrankiu naudotis nerekomenduojame, nes jo generuojamas HTML kodas neatitinka standartų.

3.7.4 Tinklalapio redagavimas naudojantis bet kokiu teksto redaktoriumi

Tinklalapius  galima  taisyti  bei  kurti  nenaudojant  specialios  programinės  įrangos.  Tam  užtenka  ir 

paprasto  teksto  redaktoriaus,  pvz.,  „Notepad“.  Čia  jau  nebematysite  HTML dokumento  redagavimui 

įprasto vaizdo, bus matomos tik HTML žymės. Pagal parodytą klaidos pranešimą suraskite atitinkamą 

vietą ir  ją pataisykite.  Labiau patyrusiems svetainių kūrėjams, dirbantiems „MS Windows“ operacinėje 

sistemoje, siūlome pabandyti standartus atitinkantį HTML redaktorių „HTML Kit“.  Jį  galite rasti  adresu: 

http://www.chami.com/html-kit/.
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4 Elektroniniai  dokumentai.  Atvirųjų  dokumentų  formatų 
svarba keičiantis informacija su gyventojais ir įmonėmis

Šiame skyriuje pateikiama informacija apie atviruosius elektroninių dokumentų formatus, jų svarbą ir 

naudą keičiantis informacija su piliečiais ar įmonėmis bei uždarųjų formatų sukeliamas problemas. Ši dalis 

skirta  ne tik  informacinių  sistemų padalinių personalui,  bet  ir  priimantiems  sprendimus,  susijusius  su 

informacinių technologijų infrastruktūros strategija ir plėtra.

4.1 Kas tai yra elektroninių dokumentų formatai?

Elektroniniai  dokumentai iš  esmės  yra  kompiuterinės  bylos  –  kitaip  tariant  tai  yra  dvejetainės 

informacijos srautas.  Kompiuterinės bylos (el. dokumento) formatas – tai yra būdas (taisyklių rinkinys) 

skirtas apibrėžti,  kokia informacija ir kaip yra pateikiama kompiuterinėje byloje. Formatas taip pat  yra 

standartas. Taigi, norint suprasti kas yra el. dokumentų ar kitų kompiuterinių bylų formatai reikia suprasti 

kas yra standartai. Tarptautinių žodžių žodyne rašoma, kad  standartas  – tai kompetentingų organizacijų 

priimtas ir patvirtintas normatyvinis dokumentas, nustatantis produkcijos, technologinių procesų, metodų, 

sąvokų,  simbolių  arba  kitų  objektų  privalomas  normas,  taisykles  ir  reikalavimus  jiems,  siekiant 

optimalios tvarkos apibrėžtoje situacijoje.

Standartas – tai bendras susitarimas dėl kažko, nustatant normas, taisykles ir reikalavimus.

Pagal tai, kas ir kaip gali susitarti ir kaip tie susitarimai bus skelbiami bei pagal jų veikimo principus, 

standartai  gali  būti  skirstomi  į  atviruosius  (laisvus)  ir  uždarus  (kurie  dažniausiai  priklauso  vienam 

gamintojui arba gamintojų grupei – kitaip sakant jie yra nuosavybiniai).

4.2 Kas tai yra atvirieji (laisvi) formatai?

Atviruosius  dokumento  formatus  (standartus)  bet  kas  gali  laisvai  naudoti,  matyti  jų  aprašymus 

(specifikacijas) bei reikšti pasiūlymus dėl tobulinimo.

Lietuvos Respublikos Vyriausybės patvirtintoje e. valdžios koncepcijoje (LR Vyriausybės nutarimas nr. 

2115 – žr.: http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184) parašyta:

„Atvirieji  formatai – tokie keitimosi  duomenimis formatai  ir  protokolai,  kurie yra išsamiai  aprašyti  ir 

kuriais galima laisvai nemokamai naudotis.“

Pagrindiniai atvirųjų formatų principai:

– Prieinamumas. Jie yra laisvai prieinami visiems (ir perskaitymo, ir įgyvendinimo prasme).

– Padidina  galutinio  vartotojo  pasirinkimo  laisvę.  Atvirieji  standartai  sukuria  sąžiningą, 

konkuruojančią  rinką  standarto  realizavimams.  Jie  „nepririša“  vartotojo  prie  konkretaus  tiekėjo  ar 

tiekėjų grupės.

– Nemokami. Atvirąjį standartą galima laisvai realizuoti visiems, už tai negali būti imamas mokestis 

(mokestis gali būti imamas tik už atitikimo standartui patikrinimą – sertifikavimą).

– Jokios diskriminacijos. Atvirieji standartai bei organizacijos, kurios juos administruoja negali teikti 

pirmenybės  vienam  realizuotojui  prieš  kitą  dėl  jokių  kitų  priežasčių  išskyrus  techninius  pateiktos 

realizacijos atitikimus standartui. Sertifikavimo organizacijos turi sudaryti galimybę patikrinti atitikimą 

standartams ir  pigiems bei nemokamiems įgyvendinimams (pvz.,  World Wide Web konsorciumas 
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leidžia bet kam nemokamai patikrinti (X)HTML ar CSS dokumentų atitikimą standartams).

Viešai pateikiamus dokumentus Lietuvos valstybės institucijos privalo publikuoti ir atviraisiais formatais 

(LR  Vyriausybės  patvirtintus  „Bendruosius  reikalavimus  valstybės  institucijų  interneto  svetainėms“  - 

nutarimas nr.  480,  20 punktas),  o  savivaldybėms ir  Lietuvos  Respublikos  Vyriausybei  nepavaldžioms 

valstybės įstaigoms bei institucijoms yra rekomenduojama vadovautis reikalavimais valstybės institucijų 

interneto svetainėms, patvirtintais šiuo nutarimu. Aukščiau minėtoje e. valdžios koncepcijoje, 7 skyriuje 

„Viešųjų paslaugų teikimo techniniai sprendimai“ taipogi akcentuojama atvirųjų formatų svarba:

„Informacijai  teikti  turi  būti  naudojami  atvirieji  formatai.  Institucijų  taikomi  bendravimo 

protokolai ir formatai neturi versti informacijos vartotojų įsigyti mokamų operacinių sistemų ar 

programinės įrangos.“

Kauno  miesto  savivaldybės  ir  Kauno  regiono  plėtros  agentūros  parengtoje  „El.  Savivaldos 

koncepcijoje“  (www.krda.lt/krdalit/projektai.html),  skyriuje  „Techniniai  sprendimai“  rašoma,  kad  ir  el. 

Savivaldoje turi būti naudojami atvirieji formatai:

„Lengvą prieinamumą prie e-Savivaldos teikiamos informacijos ir paslaugų užtikrins tai, kad sąsajai su 

naudotoju  bus  naudojamos  paplitusios  atvirojosios  technologijos  bei  visuotinai  naudojami  duomenų 

formatai,  protokolai  ir  įrenginiai.  Šios  priemonės  nevers  informacijos  naudotojų  įsigyti  mokamas 

operacines sistemas ar programinę įrangą.

4.3 Kas yra nuosavybinė (mokama) ir laisva (atvirojo kodo) 
programinė įranga?

E-Valdžios ir e-savivaldos koncepcijose pabrėžiama, kad atvirųjų technologijų bei atvirųjų dokumentų 

formatų  ir  protokolų  naudojimas  nevers  informacijos  naudotojų  įsigyti  mokamas  operacines 

sistemas ar programinę įrangą. Taigi, iškyla klausimas „kas yra mokama programinė įranga ir kokios 

yra jos alternatyvos“.  Mokama programinė įranga (dar vadinama  nuosavybine programine įranga) – tai 

vienam gamintojui arba uždarai gamintojų grupei priklausanti PĮ, kurios negalima laisvai keisti, platinti bei 

pamatyti jos išeities tekstus be gamintojo(-ų) leidimo. Nepriklausomi gamintojai negali sukurti programinės 

įrangos, 100% suderinamos su nuosavybine, nebent nuosavybinės PĮ pagrindinis duomenų išsaugojimo 

(mainų) formatas yra atviras. Jei gyventojai ar organizacijos yra priversti naudotis tik vieno gamintojo ar 

gamintojų grupės nuosavybine PĮ tuomet dingsta konkurencija. Nuosavybinė PĮ gali būti ir nemokama, 

tačiau  nėra  jokios  garantijos,  kad  jos  gamintojas  nepakels  kainos  ateityje,  priešingai  nei  yra  laisvos 

programinės įrangos atveju. Už  laisvą programinę įrangą taip pat galima imti pinigus, tačiau jos niekas 

negali uždrausti nemokamai platinti, nes bet kuris asmuo ar įmonė gali keisti, tobulinti ir platinti laisvą 

programinę įrangą be gamintojo leidimo ir be jokio mokesčio gamintojui. Kadangi laisvos programinės 

įrangos  išeities  tekstai  (programos  kodas)  yra  laisvai  prieinami  ji  dar  yra  vadinama  atvirojo  kodo 

programine įranga. 

Programinė įranga bus garantuotai nemokama tik tuo atveju, jei ji  yra laisva (jei ji  platinama pagal 

laisvas licencijas).

4.4 Atvirųjų formatų pavyzdžiai

Kad  būtų  lengviau  suprasti  kas  yra  atvirieji  formatai  ir  kokia  yra  iš  jų  nauda  pateikiame  keletą 
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pavyzdžių:

4.4.1 JPEG formatas

Tai  atviras  elektroninių paveikslėlių formatas,  standartizuojamas Joint  Photographic  Experts  Group 

(www.jpeg.org).  Kadangi  tai  atviras  formatas,  reiškia  bet  kas  gali  nemokamai  sužinoti  formato 

specifikacijas ir pagaminti produktą, kuris bus 100% suderinamas su .jpg formatu. To pasekoje dauguma 

programinės (interneto naršyklės, el. nuotraukų apdorojimo programos) ir aparatūrinės (pvz., fotoaparatų, 

mobiliųjų telefonų) įrangos gamintojų naudoja JPEG formatą nuotraukoms ar kitiems el paveikslėliams. 

Vartotojai  gali  laisvai  rinktis  kurį  įrankį  jiems  naudoti  darbui  su  JPEG  paveikslėliais,  kadangi  įvairių 

gamintojų programinė ir  aparatūrinė įranga yra pilnai  suderinama su šiuo formatu.  Taip pat  yra daug 

laisvos programinės įrangos (GIMP, „Mozilla“, „OpenOffice.org“ ir kt.), 100% palaikančios šį formatą.

4.4.2 HTML/XHTML formatas

HTML (HyperText  Markup  Language)  yra  WWW  (World  Wide  Web)  konsorciumo  (www.w3.org) 

standartizuojamas atviras formatas. Bet kas gali ne tik nemokamai sužinoti HTML specifikacijas, bet netgi 

nemokamai patikrinti konkretaus HTML dokumento atitikimą standartui  http://validator.w3.org puslapyje. 

XHTML yra pavadintas „išplečiamas HTML“ - tai naujos kartos HTML formatas.

HTML formato  privalumai  yra labai  didelis  paplitimas tarp  įvairios  programinės  įrangos  gamintojų, 

nepriklausomumas nuo jokios konkrečios kompanijos ar uždaros kompanijų grupės (standartizuojamas 

www.w3.org konsorciumo),  taip  pat  geras  HTML formato  palaikymas  laisvoje  programinėje  įrangoje 

(„Mozilla“, „Firefox“, „NVU“, „OpenOffice.org“ ir kt.).

4.4.3 OpenDocument formatas

OpenDocument (Open Document Format for Office Applications)– tarptautinės organizacijos OASIS 

(www.oasis-open.org)  standartizuojamas  biuro  dokumentų  formatas,  sukurtas  XML formato  pagrindu. 

Universaliausias iš visų (atvirųjų ir uždarų) biuro dokumentų formatų, turi daugiausia galimybių – tinka visų 

tipų (teksto,  grafikos,  elektroninių lentelių,  prezentacijų,  grafikų,  matematinių formulių,  pildomų formų, 

duomenų bazių) biuro dokumentų saugojimui, turi skaitmeninio parašo palaikymą ir pan. Palaikomas ir 

naudojamas smulkių ir stambių programinės įrangos gamintojų produktuose – SUN, IBM, Novell, Oracle, 

KDE ir  t.t.  Pripažintas  Europos  Komisijos,  Europos  Sąjungos  institucijų  bei  kai  kurių  ES šalių  narių. 

Planuojama,  kad  2005  metų  pabaigoje  OpenDocument formatas  taps  ISO  (International  Standards 

Organization) standartu.

4.4.4 PDF formatas

PDF  (Portable  Document  Format)  –  Adobe  kompanijai  priklausantis,  tačiau  atviras  formatas.  Jis 

labiausiai tinka praktiškai bet kokio tipo neredaguojamiems dokumentams publikuoti. Pakankamai plačiai 

paplitęs,  tačiau  palyginus  su  HTML  palaikomas  daug  mažiau  programinės  įrangos  gamintojų.  Yra 

pakankamai  laisvos  programinės  įrangos  (pvz.,  „OpenOffice.org“,  „PDFCreator“)  dokumentų 

konvertavimui į PDF formatą.
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4.5 Kas tai yra uždari formatai?

Uždaras  formatas  (standartas)  –  dažniausiai  vieno  gamintojo  arba  uždaros  gamintojų  grupės 

naudojamas standartas, kurio aprašymas (specifikacija) nėra paskelbtas viešai ir kuriuo negalima laisvai 

pasinaudoti. Uždari formatai neleidžia keistis informacija (pvz., elektroniniais dokumentais) tarp skirtingų 

gamintojų ir nesuteikia galimybės vartotojui laisvai rinktis. Uždari formatai kenkia konkurencijai, vartotojas 

papuola į „spąstus“, nebegali pakeisti tiekėjo. Tai sąlygoja aukštesnius programinės įrangos naudojimo 

kaštus.

4.6 Problemos dėl uždarų formatų

Dabartiniu metu Lietuvoje yra plačiai paplitusi nuosavybinė „Microsoft“ korporacijos gaminama, biuro 

programinė įranga bei  tai  pačiai firmai  priklausantys uždari  dokumentų formatai  (*.doc ;  *.xls ;  *.ppt), 

kuriais  dažnai  yra  pateikiama  vieša  informacija  gyventojams  bei  įmonėms.  Tai  kelia  didelę  grėsmę 

Lietuvos ekonomikai, kadangi Lietuvos valstybinės ir komercinės institucijos tapo priklausomos nuo šios 

užsienio kompanijos, piliečiai bei įmonės yra verčiami pirkti ar nelegaliai naudoti tik šio vieno gamintojo 

produktus  –  taigi  tampa  neįmanomas  laisvas  pasirinkimas  ir  užkertamas  kelias  konkurencijai  tarp 

gamintojų. Pagal LR įstatymus (LR Vyriausybės nutarimą nr. 480) valstybės institucijos privalo teikti viešus 

dokumentus ir atviraisiais formatais, tas pats teigiama ir e. valdžios koncepcijoje, deja dauguma valstybės 

institucijų nesilaiko šio privalomo (o savivaldybėms rekomenduojamo) LR Vyriausybės nutarimo.

Dabartinėje situacijoje, naudojant vien uždarus dokumentų formatus informacijos mainams kyla tokios 

problemos:

– Nepriklausomi programinės įrangos kūrėjai negali sukurti programinės įrangos, 100% suderinamos 

su uždaru formatu – dabartiniu metu nėra (ir greičiausiai niekada nebus) jokios programinės įrangos, 

pilnai suderinamos su „MS Office“ dokumentų formatu, išskyrus „Microsoft“ gaminamus produktus.

– Šie dokumentų formatai yra „Microsoft“ (JAV kompanijos) nuosavybė.

– Skatinamas,  propaguojamas  vieno  gamintojo  produktų  naudojimas  (dėl  to,  kad  kitiems 

gamintojams neįmanoma pagaminti pilnai suderinamo produkto).

– Neužtikrinamas laisvas priėjimas prie viešosios informacijos neturint „Microsoft“ produktų – piliečiai 

bei įmonės yra priversti pirkti arba nelegaliai naudoti šiuos produktus.

4.7 Praktinė atvirųjų formatų nauda

– Dokumentai OpenDocument, HTML ar PDF formatais dažniausiai užima gerokai mažiau vietos nei 

„MS Office“ formatu, vadinasi internetu bus galima greičiau atsisiųsti ar nusiųsti. Pavyzdžiui Vilniaus 

miesto  savivaldybės  (www.vilnius.lt)  „MS  Office“  (.doc)  formatu  pateikiami  „Vilniečių  apklausos 

rezultatai“ užima 4,5Mb, tą patį dokumentą konvertavus į PDF formatą, jis sumažėjo 4,5 karto – iki 

1Mb, o konvertavus į OpenDocument formatą jis sumažėjo net 6,5 karto – jo dydis tapo 0.7 Mb !

– atvirieji  formatai  yra  saugesni  ir  atsparesni  virusams,  pvz.,  konvertavus  virusu  užkrėstus  „MS 

Office“ dokumentus į OpenDocument, HTML ar PDF formatą virusas tampa neveiksmingas
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– OpenDocument bei PDF formatai turi integruotą skaitmeninio parašo galimybę.
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5 Elektroninių dokumentų, naudojamų savivaldos 
institucijose, apžvalga

Išanalizavus  Lietuvos  savivaldos  institucijose  viešai  pateikiamą  informaciją  pamatėme,  kad 

savivaldybės publikuoja el. dokumentus tokiais formatais:

– atviru HTML formatu;

– atviru PDF formatu;

– uždarais „MS Office“ formatais (.doc, .xls, .pdf).

Vilniaus  miesto  savivaldybėje,  kai  kurie  blankai  (sutarčių  šablonai  ir  pan.)  yra  publikuojami  RTF 

formatu.

Dauguma  savivaldybių  interneto  svetainėse  pateikiamų  dokumentų  yra  skirti  tik  peržiūrėjimui 

(perskaitymui), o ne redagavimui.

Savivaldybės publikuoja dokumentus, kuriems reikia tiksliai pritapti prie spausdinamo formato (blankai, 

sutarčių šablonai ir kt.).

Šiuo metu (2005 metais) savivaldybės nepriima informacijos (duomenų) iš fizinių ar juridinių asmenų 

elektroniniu būdu.

Šiuo metu yra tokios problemos su dokumentų publikavimu:

– didelė dalis informacijos prieinama tik uždarais „MS Office“ formatais (.doc, .xls, .pdf), taigi, šiuo 

metu, savivaldybės verčia gyventojus ir įmones pirkti arba nelegaliai naudotis brangia vieno gamintojo 

(„Microsoft“) operacine sistema ir tik to paties gamintojo programine įranga, nors ir LR Vyriausybės 

patvirtintuose  „Bendruosiuose  reikalavimuose  valstybės  institucijų  interneto  svetainėms“  (LR 

Vyriausybės nutarimas nr. 480, jais rekomenduojama vadovautis ir savivaldybėms), ir e-valdžios (LR 

Vyriausybės  nutarimas  nr.  2115),  ir  Kauno regiono  plėtros  agentūros  parengtoje  „El.  Savivaldos“ 

(www.krda.lt/krdalit/projektai.html)  koncepcijose  teigiama,  kad  „Informacijai  teikti  turi  būti 

naudojami atvirieji formatai. Institucijų taikomi bendravimo protokolai ir formatai neturi versti 

informacijos vartotojų įsigyti mokamų operacinių sistemų ar programinės įrangos.“ Matyt, kad 

„žodžiais, ne darbais, mes Tėvynę mylim“...

– Nėra vieningos tvarkos – nors praktiškai visi dokumentai yra skirti tik skaitymui ar spausdinimui (ne 

redagavimui), tačiau vieni dokumentai pateikiami HTML formatu, analogiškoje vietoje ir analogiško 

turinio kiti dokumentai – PDF formatu, analogiški treti – tik uždaru „MS Office“ formatu (.doc ar .xls), 

nors nėra jokios priežasties pateikti vien tik uždaru „MS Office“ formatu, kadangi dokumentai nėra 

skirti  redagavimui  (žr.  pvz.,  www.vilnius.lt ar  www.kaunas.lt dešiniame  svetainių  šone  esančias 

naujienas (aktualijas) arba Kauno savivaldybės pateikiamus licencijų ir leidimų sąrašus).
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6 Tinkamiausio formato pasirinkimo taisyklės bei nurodymai 
svetainių turinio pildytojams

Šiame skyriuje jūs detaliau sužinosite kokie yra populiariausi atvirieji elektroninių dokumentų formatai, 

kokios yra kiekvieno formato galimybės, privalumai bei trūkumai ir  kokį  formatą pasirinkti  atitinkamoje 

situacijoje. Ši dalis skirta ne tik informacinių sistemų padalinių personalui, bet ir priimantiems sprendimus, 

susijusius su informacinių technologijų infrastruktūros strategija ir plėtra, pvz., rengiantiems reikalavimus 

dokumentų valdymo sistemos pirkimo konkursui.

6.1 Viešai publikuojamų elektroninių dokumentų formatų parinkimo 
kriterijai

Viešai publikuojami dokumentai turėtų būti pateikiami atviraisiais formatais (kas yra tie atvirieji formatai 

parašyta ankstesniuose skyriuose).

Parenkant viešai publikuojamų elektroninių dokumentų formatus mes naudojome tokius kriterijus:

– Paplitimas.  Formatas  turi  būti  naudojamas  daugiau  nei  vienos  kompanijos  gaminamuose 

produktuose.

– Nepriklausomumas.  Formatas  neturėtų  priklausyti  ir  jo  vystymosi  neturėtų  nulemti  tik  viena 

kompanija ar uždara kompanijų grupė – t.y. formatas neturėtų būti nuosavybinis.

– Portabilumas. Užtikrinimas, kad dokumentų formatą pilnai palaikančios programinės įrangos yra 

sukurta įvairioms operacinėms sistemoms, tame tarpe ir laisvoms, nemokamoms OS.

– Formato  palaikymas  laisvoje  programinėje  įrangoje.  Tai  užtikrina,  kad  darbui  su  tuo  atviruoju 

formatu visada bus nemokamų programų (tik laisvos programos visada bus nemokamos).

6.2 Perspektyviausi atvirieji elektroninių dokumentų formatai bei 
pasirinkimo taisyklės konkretiems atvejams

Atvirųjų elektroninių dokumentų formatų yra visokių: vieni formatai yra universalūs – jie tinka visokių 

tipų dokumentams, jais išsaugotus dokumentus galima ir skaityti, ir spausdinti, ir redaguotu; kiti formatai 

tinka tik atskirais atvejais, pvz., tik teksto dokumentams bei taškinei grafikai, tačiau jie yra paprastesni ir 

todėl juos palaiko daugiau programinės įrangos. Taigi – prieš pasirenkant, kuris formatas jums labiausiai 

tinka  konkrečioje  situacijoje,  reikia  išsamiau  susipažinti  su  labiausiai  paplitusiais  ir  labiausiai 

perspektyviais  atviraisiais  dokumentų  formatais,  jų  privalumais  bei  trūkumais.  Pradžioje  aprašysime 

senesnius,  Lietuvoje  jau  paplitusius,  formatus,  o  toliau  kitus,  naujesnius,  tačiau  daugiau  galimybių 

turinčius, perspektyvius formatus:

6.2.1 HTML/XHTML formatas

HTML (HyperText  Markup  Language)  yra  WWW  (World  Wide  Web)  konsorciumo  (www.w3.org) 

standartizuojamas formatas. HTML formatas yra daugiau nebetobulinamas, o tolesni tobulinimo darbai 

perkeliami į išplėstą HTML formatą, pavadiną XHTML.

Privalumai:

– labai paplitęs, portabilus, palaikomas daug programinės įrangos gamintojų,
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– nepriklausomas  nuo  jokios  konkrečios  kompanijos  ar  uždaros  kompanijų  grupės, 

standartizuojamas  www.w3.org konsorciumo,

– formatą palaiko daug laisvos programinės įrangos („Mozilla“, „Firefox“, „NVU“, „OpenOffice.org“ ir 

kt.).

Trūkumai:

– netinka  atvaizduoti  labai  sudėtingoms  lentelėms,  labai  sudėtingoms  formoms,  trimačiams 

vaizdams ir pan., taip pat kuomet reikia tiksliai suderinti su spausdinamu popieriaus formatu,

– kai kurie programinės įrangos gamintojai nesilaiko šio formato standarto (pvz., „MS Frontpage“ 

HTML dokumentą sukuria su klaidomis, t.y. neatitinkančio standarto, dėl ko dauguma kitų gamintojų 

PĮ atvaizduoja tokį dokumentą skirtingai).

6.2.2 PDF formatas

PDF (Portable Document Format)  – kompanijai  „Adobe“ priklausantis,  tačiau atviras formatas.  Yra 

sukurta pakankamai laisvos programinės įrangos, palaikančios PDF formatą, tačiau ne visos jos pilnai 

palaiko visas PDF formato galimybes.

Privalumai:

– labai paplitęs, tačiau palaikomas gerokai mažiau gamintojų nei HTML standartas,

– portabilus – darbui su PDF formatu yra programinės įrangos daugumoje operacinių sistemų.

– Labai  gerai  tinka  visų  tipų  (tekstiniams,  prezentacijoms  ir  pan.)  neredaguojamiems  biuro 

dokumentams,  kuomet  reikia  tiksliai  suderinti  su  spausdinamu  popieriaus  formatu  (blankams, 

sutartims ir kt.)

– saugus, turi skaitmeninio parašo galimybę;

– Yra laisvos programinės įrangos automatizuotam dokumentų konvertavimui į PDF formatą.

Trūkumai:

– priklausomas nuo vienos kompanijos,

– pigios (nemokamos, laisvos) PDF dokumentų kūrimo priemonės nepaplitę Lietuvoje,

– praktiškai  netinka  redaguojamiems  dokumentams.  (Yra  išplėstas  PDF forms  formatas,  tačiau 

šioms PDF formoms pildyti praktiškai tėra tik vieno gamintojo – Adobe uždara programinė įranga)

6.2.3 OpenDocument formatas

OpenDocument (Open Document Format for Office Applications) yra tarptautinio konsorciumo OASIS 

(Organization  for  the  Advancement  of  Structured  Information  Standards -  www.oasis-open.org) 

standartizuojamas  biuro  dokumentų  formatas,  sukurtas  pripažintų  XML  pagrįstų  formatų  (XHTML, 

XForms, XLink, SVG, MathML ir kt.) pagrindu.

OpenDocument  neseniai  standartizuotas  (OpenDocument  v1.0  pripažintas  OASIS  standartu  2005 

gegužės 1d.), todėl dar nelabai paplitęs, tačiau jau dabar yra palaikomas ir naudojamas smulkių ir stambių 

programinės įrangos gamintojų produktuose – SUN, IBM, „Novell“, „Oracle“, KDE, GNOME ir kt.

Nors OpenDocument yra naujas standartas, tačiau jis yra padarytas laiko patikrinto OpenOffice.org 1.0 

XML formato  pagrindu  (milijonai  vartotojų  naudojosi  daugiau  nei  4  metus  „OpenOffice.org“  1.0  XML 

formatu,  kuris  buvo  pagrindinis  OpenOffice  1.x  bei  StarOffice  6.x  ir  7.x  versijose).  OpenDocument 
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formatas yra pripažintas Europos Komisijos bei Europos Sąjungos, šis formatas yra sparčiai plintantis – 

vis daugiau programinės įrangos gamintojų pradeda palaikyti šį formatą.

Privalumai:

– nepriklausomas  nuo  vieno  gamintojo  ar  gamintojų  grupės  –  standartizuojamas  tarptautinio  ne 

pelno siekiančio el. verslo standartų konsorciumo OASIS;

– pradedamas standartizuoti tarptautinėje standartų organizacijoje ISO, tuomet taps ISO standart;,

– portabilus – darbui su OpenDocument formatu yra programinės įrangos daugumoje operacinių 

sistemų;

– universaliausias  iš  visų  (atvirųjų  ir  uždarųjų)  biuro  dokumentų  formatų,  tinka  visų  tipų  biuro 

dokumentams  (tekstui,  grafikai  ir  paveikslėliams,  elektroninėms  lentelėms,  prezentacijoms, 

grafikams, matematinėms formulėms, pildomoms formoms, duomenų bazėms ir t.t.), turi daugiausia 

galimybių;

– saugus, turi skaitmeninio parašo galimybę;

– yra laisvos programinės įrangos, pilnai palaikančios šį formatą.

Trūkumai:

– dauguma programinės įrangos, palaikančios šį formatą šiuo metu (2005 m. gegužės mėn.) yra 

beta stadijoje (stabilios versijos planuojamos 2005 vasarą).

6.2.4 XForms formatas (standartas)

XForms – tai specializuotas formatas (standartas), skirtas įvairių formų pildymui bei į formas įvestų 

duomenų tikrinimui  ir  perdavimui  internetu.  Tai  nepriklausomas  standartas,  standartizuojamas  WWW 

(World Wide Web) konsorciumo (www.w3.org/MarkUp/Forms/).

XForms  yra  PDF  Forms  bei  kitų,  nuosavybinių  elektroninių  formų  formatų  alternatyva,  leidžianti 

vartotojui  pildyti  sudėtingas  formas  tiesiai  naršyklėje  arba  atskira  programa.  Kaip  ir  HTML formatas 

XForms yra nepriklausomas, portabilus, palaikomas daugelio programinės įrangos gamintojų, tame tarpe 

ir laisvos programinės įrangos, pvz., „OpenOffice.org 2.x“, „Mozilla FireFox“ ir kt.

6.2.5 Neperspektyvūs (neturintys ateities) dokumentų formatai

Ne visus atviruosius formatus verta naudoti viešos informacijos pateikimui ar keitimuisi – kai kurie 

formatai turi labai mažai galimybių arba yra labai mažai programinės įrangos, kuri pilnai palaikytų formatą, 

arba įvairi programinė įranga skirtingai interpretuoja tą patį formatą, dėl ko atsiranda nesuderinamumai. 

Taip pat kartais pasitaiko, kad vienas formatas pasensta ir tampa neprižiūrimas (nebetobulinamas), šiuo 

atveju dažnai vietoj seno formato atsiranda daugiau galimybių turintis naujas. Trumpai parašysime kokių 

plačiau žinomų atvirųjų formatų reiktų vengti publikuojant informaciją viešai ar keičiantis duomenimis su 

fiziniais ar juridiniais asmenimis.

Vienas  iš  neperspektyvių,  tačiau  gana  plačiai  paplitusių  dokumentų  formatų  yra  RTF  (Rich  Text 

Format).  RTF  formatą  dar  ir  dabar  retkarčiais  naudoja  kai  kurios  įstaigos  viešai  pateikiamiems 

dokumentams publikuoti. Pagrindiniai šio formato trūkumai yra tokie:

– Turi mažai galimybių, neatitinka šių dienų reikalavimų – tinka tik teksto dokumentams be sudėtingų 

lentelių, teksto įvedimo formų ar kitų sudėtingesnių objektų. Neturi skaitmeninio parašo galimybės, 
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taigi yra nesaugus.

– Skirtinga programinė įranga  RTF dokumentą  atvaizduoja  šiek  tiek  skirtingai  (o  kartais  ir  labai 

skirtingai), todėl nėra garantijos, kad su viena programine įranga sukurtas RTF formato dokumentas 

taip pat atrodys ir atsidarius su kita programine įranga ar netgi su kita tos pačios programos versija.

– RTF  formatas  yra  priklausomas  nuo  vieno  gamintojo  („Microsoft“),  taigi,  jis  yra  nuosavybinis, 

niekas išskyrus šią įmonę neprižiūri šio formato ir negali įtakoti šio formato vystymosi (negali tobulinti).

– Populiariausiose operacijų sistemose praktiškai nėra programinės įrangos, pilnai palaikančios šį 

formatą.  Netgi  tas gamintojas,  kuriam priklauso šis  formatas („Microsoft“),  negamina programinės 

įrangos, kurios pagrindinis formatas būtų RTF, dėl to dažnai atsitinka taip, kad kai kurie dokumento 

elementai, formatavimas ar pakeitimai neišsisaugo arba neteisingai išsisaugo įrašant dokumentą RTF 

formatu.

RTF formatas gana plačiai paplito dėl to, kad seniau nebuvo universalaus atvirojo formato tekstiniams 

dokumentams, kuris būtų palaikomas stambiųjų programinės įrangos gamintojų, taip pat dėl to, kad šis 

formatas yra gana paprastas ir jį lengva buvo pritaikyti nesudėtingoms (turinčioms mažai galimybių) tekstų 

redagavimo  programoms.  Tačiau  šiais  laikais,  kai  programose atsiranda  vis  daugiau  galimybių,  RTF 

formatas tampa nebetinkamas dėl aukščiau paminėtų trūkumų.

Kokius  formatus  geriausia  naudoti  vietoj  RTF?  Priklausomai  nuo  aplinkybių,  vietoj  RTF  geriausia 

naudoti HTML, PDF arba OpenDocument, pvz., jei reikia pateikti dokumentus, kuriuose nėra sudėtingų 

lentelių bei nereikia tiksliai pritapti  prie spausdinimo popieriaus formato tai geriausia naudoti  HTML ar 

XHTML  formatą,  o  neredaguojamiems  biuro  dokumentams,  kuomet  reikia  tiksliai  suderinti  su 

spausdinamu popieriaus  formatu  (blankams,  sutartims ir  t.t.)  geriausiai  tinka  PDF formatas.  Žinoma, 

galima papildomai naudoti ir visais atvejais tinkantį, universalųjį OpenDocument formatą.

Kitas  gana  plačiai  paplitęs,  tačiau  viešos  informacijos  publikavimui  nerekomenduojamas  atvirasis 

dokumentų formatas yra senas OpenOffice 1.0 formatas. Jis yra neperspektyvus todėl, kad šio formato 

pagrindu  buvo  sukurtas  naujas  OpenDocument  formatas,  kuris  turi  daugiau  galimybių  ir  yra  plačiai 

palaikomas tarp stambiųjų ir kitų programinės įrangos gamintojų bei Europos Sąjungos institucijų. Kitaip 

sakant OpenOffice 1.0 XML formatas yra praktiškai sena OpenDocument formato versija, kuri per kelis 

metus išnyks, kadangi visa programinė įranga, palaikanti OpenOffice 1.0 XML formatą pereina arba greitu 

laiku pereis prie OpenDocument formato (arba OpenDocument formatas turės didesnį prioritetą).

6.2.6 Tinkamiausio formato pasirinkimo taisyklės bei nurodymai svetainių turinio 
pildytojams

Pasirenkant  formatus  viešai  publikuojamiems  dokumentams  reikia  pradžioje  išsiaiškinti  kokio  tipo 

dokumentus ir kokiu tikslu reikia pateikti internete. Priklausomai nuo to reikia rinktis atitinkamą dokumentų 

formatą, atsižvelgiant į kiekvieno formato privalumus bei trūkumus:

– šiuo metu patogiausias (iš interneto svetainės naudotojo pusės) ir labiausiai įvairios programinės 

įrangos  palaikomas  yra  XTML (XHTML)  formatas,  taigi  reikia  stengtis  visą  įmanomą informaciją 

pateikti  būtent šiuo formatu. Kaip jau minėta anksčiau – HTML formatas netinka atvaizduoti  labai 

sudėtingoms lentelėms, labai sudėtingoms formoms, trimačiams vaizdams ir pan., taigi šiuo atveju 

reikės rinktis kitus atviruosius formatus. HTML formas taip pat netinka kai reikia tiksliai pritapti prie 
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spausdinamu popieriaus formato – t.y. sutarčių, blankų pavyzdžiams, kuriuos gyventojai ar įmonės 

turėtų atsispausdinę užpildyti. Tokiam tikslui labai tinka PDF ir OpenDocument formatai.

– Jei nėra galimybės kokių nors redagavimui neskirtų dokumentų pateikti HTML formatu – tuomet 

reiktų naudoti PDF ir OpenDocument formatus. Netgi sudėtingų dokumentų konvertavimas į šiuos 

formatus yra labai paprastas ir neužimantis daug laiko – tereikia pasinaudoti atitinkama programine 

įranga – žr. sekantį skyrių.

– Redaguojamiems dokumentams ir  dauguma kitų atvejų,  kuriems netinka HTML ar  PDF (pvz., 

sudėtingoms  elektroninėms  lentelėms),  tiks  universalusis  OpenDocument  formatas.  Žinoma, 

OpenDocument galima naudoti kaip papildomą formatą ir visais kitais atvejais, kur tinka ir HTML ir 

PDF.  OpenDocument  dokumentų  peržiūrai  galima  naudoti  OpenOffice.org  Viewer,  daugiau 

informacijos apie jį yra http://oooview.dev.java.net 

Dokumentų mainams geriausia naudoti OpenDocument, XForms arba PDF forms.

Svetainių turinio pildytojams reiktų nepamiršti, kad vartotojams dokumentus galima pateikti ne vienu, o 

keliais populiariausiais formatais, pvz., labiausiai paplitusiu uždaru formatu bei labiausiai tinkamu atviru – 

tuomet visokios programinės įrangos naudotojai galės patogiai ir laisvai pasinaudoti viešai publikuojama 

informacija.

6.3 Kiti veiksniai, pririšantys vartotoją prie konkretaus gamintojo ar 
uždaros gamintojų grupės

Rekomenduojame  naudoti  laisvus  šriftus.  Universalių  laisvų  TrueType,  Type1  ir  OpenType  šriftų, 

turinčių daugelio tautų simbolius galima rasti http://www.freesoftware.fsf.org/freefont  Nerekomenduojama 

naudoti riboto platinimo šriftų, kaip Times New Roman ar Arial ar Verdana ar Tahoma.

Informacijos apie laisvus vektorinius šriftus yra www.akl.lt/skaitykla dokumentacijos skyriuje. Taip pat 

yra  neaiškios  licencijos  už  Lietuvos  mokesčių  mokėtojų  pinigus  daromas  šriftas  „Palemonas“,  žr.: 

http://www.vlkk.lt/palemonas.html 

Nedėkite į dokumentus patentuotų ar riboto platinimo objektų, pvz., paveiksliukų patentuotais formatais 

ar netgi citatų iš riboto platinimo dokumentų, kuriuos draudžiama cituoti negavus kažkieno leidimo.

Dokumentų suspaudimui nenaudokite uždarų ar patentuotų algoritmų (archyvų formatų) kaip RAR, 

ACE ar pan.,  taip pat  nenaudokite savaime išsipakuojančių archyvų, kurie veikia tik  vienoje operacijų 

sistemoje (.EXE arba .COM bylų formatai). Viešai platinamiems dokumentams suspausti geriausiai tinka 

.ZIP formatas, o jei reikia didesnio suspaudimo – 7-zip (www.7-zip.org) arba BZip2.
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7 Dokumentų kūrimas atviraisiais formatais bei 
egzistuojančių dokumentų konvertavimas į atviruosius 
formatus

Šiame skyriuje trumpai apžvelgsime programinę įrangą, skirtą kurti dokumentus atviraisiais formatais 

bei detaliau išnagrinėsime kelis įrankius, skirtus konvertuoti egzistuojančius uždaro formato dokumentus į 

atviruosius formatus.

7.1 Programinė įranga, palaikanti atviruosius formatus

Programinei  įrangai,  skirtai  kurti  dokumentus  atviraisiais  formatais  bei  konvertuoti  egzistuojančius 

uždaro formato dokumentus į atviruosius formatus, papildomų lėšų dažniausiai neskiriama, taigi šiame 

skyriuje  pagrinde  kalbėsime  apie  laisvąją  (atvirojo  kodo)  ir  šiaip  nemokamą programinę  įrangą,  kuri 

palaiko aukščiau minėtus atviruosius formatus. Pradžioje aprašysime universaliausią, daugiausiai formatų 

palaikančią programinę įrangą, o toliau – konkretiems formatams skirtas programas.

7.1.1 Universali programinė įranga, palaikanti daugumą atvirųjų ir uždarų formatų 
(OpenOffice.org 2.x bei StarOffice 8.x)

Laisvas  „OpenOffice.org“  biuro  programų  paketas  (atsisiųsti  galima  iš  www.openoffice.org bei 

www.openoffice.lt) sparčiai tobulėja ir nuo 2.0 versijos palaiko šiuos dokumentų formatus:

– HTML ir XHTML,

– OpenDocument,

– PDF (įskaitant ir PDF formas),

– „MS Office“ - *.doc , *.xls , *.ppt (įskaitant ir „MS Office“ 2003 XML formatus),

– RTF (Rich Text Format),

– delninių kompiuterių biuro programų formatus,

– daug kitų formatų, įskaitant XForms, Docbook bei MathML.

Su „OpenOffice.org“ programine įranga galima ir kurti naujus dokumentus dauguma atvirųjų bei uždarų 

formatų, ir konvertuoti iš vieno palaikomo formato į kitą.

Kadangi komercinis „StarOffice“ biuro programų paketas daromas „OpenOffice.org“ pagrindu taigi tuos 

pačius formatus palaiko ir „StarOffice“ nuo 8.0 versijos.

7.1.2 PDF formato dokumentams skirta programinė įranga (PDFCreator, CUPS-
PDF, Scribus, Adobe Reader, kt.)

Bet  kokio  formato  dokumentą  (tekstinį  dokumentą,  el.  lentelę,  brėžinį,  prezentaciją  ir  t.t.)  galima 

paversti  į  neredaguojamą PDF formato dokumentą su PDFCreator  (www.pdfcreator.de.vu,  skirtas MS 

Windows OS)  ar  CUPS-PDF (skirtas  Linux  ir  kitoms  UNIX tipo OS)  programine įranga.  Įdiegius  šią 

laisvąją programinę įrangą atsiranda galimybė iš  bet  kurios jūsų naudojamos programos spausdinti  į 

virtualųjį PDF spausdintuvą, į kurį pasiųsti dokumentai pavirs PDF formato bylomis. Šią programinę įrangą 

galima įdiegti į vietiniam tinkle esantį kompiuterį ir tinkle paviešinti (share) virtualųjį PDF spausdintuvą – 
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tuomet visi tinkle esantys kompiuteriai galės konvertuoti savo dokumentus į PDF formatą.

PDF  formas  galima  kurti  su  Scribus  (www.scribus.org.uk)  maketavimo  programa.  Detalesnę 

informaciją apie tai rasite www.akl.lt/skaitykla esančioje dokumentacijoje.

Daugiausia  nuosavybinės  programinės  įrangos  darbui  su  PDF  formatu  gamina  Adobe  firmos 

(www.adobe.com), čia rasite ir nemokamą PDF bylų peržiūrėjimo bei PDF formų pildymo programą Adobe 

Reader. 

7.1.3 HTML ir XHTML formato dokumentų redaktorius NVU

HTML ir XHTML dokumentų kūrimui ir egzistuojančių HTML formato bylų tvarkymui geriausiai tinka 

laisvas  HTML redaktorius  NVU,  kurį  galima  parsisiųsti  iš  www.nvu.com.  Šis  įrankis  yra  pakankamai 

galingas profesionalams bei pakankamai paprastas ir patogus pradedančiajam vartotojui.

NVU generuojamas HTML kodas atitinka oficialias HTML specifikacijas, taigi rankinių kodo pataisymų 

neprireikia.

7.2 Egzistuojančių dokumentų konvertavimas į atviruosius formatus 
bei atvirųjų formatų dokumentų konvertavimas į uždarus

Mažiems  dokumentų  kiekiams  konvertuoti  pakanka  pasinaudoti  OpenOffice.org  2.x  (arba  SUN 

StarOffice 8.x ar naujesnio) paketo „Išsaugoti kitaip“ (Save As) funkcija – t.y. „Išsaugoti kitaip“ (Save As) 

dialoge pasirinkti norimą formatą. Tačiau jei reikia iškart konvertuoti didesnį kiekį dokumentų šis būdas yra 

nepatogus ir  atimantis  daug laiko.  Didesniems dokumentų kiekiams patogiai  konvertuoti  yra sukurtos 

specialios priemonės kurios ir yra aprašomos šiame skyriuje.

7.2.1 Konvertavimas į PDF formatą pasinaudojant virtualaus PDF spausdintuvo 
programine įranga

Bet  kokio  formato  dokumentą  (tekstinį  dokumentą,  el.  lentelę,  brėžinį,  prezentaciją  ir  t.t.)  galima 

paversti  į  neredaguojamą PDF formato dokumentą su PDFCreator  (www.pdfcreator.de.vu,  skirtas MS 

Windows OS)  ar  CUPS-PDF (skirtas  Linux  ir  kitoms  UNIX tipo  OS)  programine  įranga.  Įdiegius  šią 

laisvąją  programinę įrangą atsiranda galimybė iš  bet  kurios  jūsų naudojamos programos spausdinti  į 

virtualųjį PDF spausdintuvą, į kurį pasiųsti dokumentai pavirs PDF formato bylomis. Šią programinę įrangą 

galima įdiegti į vietiniam tinkle esantį kompiuterį ir tinkle paviešinti (share) virtualųjį PDF spausdintuvą – 

tuomet visi tinkle esantys kompiuteriai galės konvertuoti savo dokumentus į PDF formatą.

7.2.2 Konvertavimas į OpenDocument formatą

Dokumentų konvertavimui iš bei į atvirą OpenDocument formatą yra keletas priemonių, pasirinkti jas 

reikėtų  pagal  situaciją  bei  galimybes.  Patogiausia  yra  įdiegti  OpenOffice.org  programinę  įrangą  (ne 

senesnę nei 2.0 versiją) ir pasinaudoti jos teikiamomis galimybėmis. OpenOffice.org paketas iškart turi 

priemones automatiniam diske esančių dokumentų konvertavimui į OpenDocument formatą.

Didelio  kiekio  dokumentų  konvertavimui  į  OpenDocument  formatą  naudojamas  dokumentų 

konvertavimo vedlys (“Document  Converter”). Šią funkciją galima iškviesti iš bet kurios OpenOffice.org 

programos pagrindinio meniu: „Byla->Vedlys->Dokumento konvertavimas...“ (“File->Wizards->Document 
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Converter...”).

Atsidariusiame lange pasirinkite iš kokio tipo dokumentus konvertuosite į OpenDocument formatą ir 

paspauskite „Toliau>>“ (“Next>>”).

Kiekvienam konvertuojamų dokumentų tipui nurodykite, iš kokio katalogo imsite dokumentus ir  kur 

juos padėsite. Jei nekūrėte šablonų patariame nuimti varnelė nuo „Word, Excel ar PowerPoint šablonų“ 

(templates). Paspauskite „Toliau>>“ (“Next>>”).

Priešpaskutiniame  lange  surašyti  visi  jūsų  konvertavimo  nustatymai.  Jei  parodyti  nustatymai  jums 

tinkami paspauskite mygtuką „Konvertuoti (“Convert”). 
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Galiausiai atsidaro langas, kuriame rodomas konvertavimo progresas:

baigus konvertavimą galima paspausti mygtuką „Rodyti protokolo bylą“ („Show Log File“) ir peržiūrėti 

detalią statistiką:
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Jei neužtenka OpenOffice.org pakete esančio dokumentų konvertavimo vedlio galimybių, ar darbas su 

juo  nėra  pakankamai  greitas,  tai  galite  pasinaudoti  sekančiame  skyriuje  aprašytais  universaliais 

konvertavimo įrankiais, kurie tinka daugumai uždarų ir atvirųjų formatų.

7.2.3 Universalūs konvertavimo įrankiai tinkantys daugumai uždarų ir atvirųjų 
formatų

Jei  norite  konvertuoti  daug  dokumentų  iš  OpenDocument,  OpenOffice  1.0,  „MS  Office“  ar  kitų 

OpenOffice.org  paketo  suprantamų  formatų  į  „MS  Office“,  OpenDocument,  OpenOffice  1.0  ar  kitus 

OpenOffice.org paketo suprantamus formatus galite pasinaudoti DocConverter bei BatchConv įrankiais, 

kuriuos galima atsisiųsti iš:

http://converter.openoffice.lt 

http://www.ooomacros.org 

http://oooconv.free.fr/batchconv 

Šie įrankiai  yra padaryti  OpenOffice.org vidinių programavimo priemonių (macros)  pagalba,  jie  yra 

platinami kaip OpenDocument formato dokumentai. Juos atidarant gausite saugumo įspėjimą:
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Spauskite mygtuką „Enable macros“, priešingu atveju šie įrankiai neveiks.

1 BatchConv įrankis

Šį  įrankį  galite  atsisiųsti  iš  http://converter.openoffice.lt (gamintojo  puslapis  yra 

http://oooconv.free.fr/batchconv ). BatchConv pagrindinis privalumas yra galimybė labai paprastai ir greitai 

(praktiškai vieno mygtuko paspaudimu) skirtingų tipų ir skirtingų formatų bylas konvertuoti  į  vieno tipo 

formatą,  pvz.,  galima  ir  „MS  Word“,  ir  „OpenOffice.org“,  ir  „MS  Excel“  bylas  konvertuoti  į  PDF  ar 

OpenDocument formatą vienu žingsniu.

Žemiau  pateiktas  įrankio  BatchConv  vaizdas.  Paspauskite  mygtuką  „Pridėti  bylas  į  sąrašą“  ir 

atsiradusiame dialoge išsirinkite bylas, kurias norite konvertuoti. Jei norite pridėti bylų iš kito katalogo – 

paspausite mygtuką „Pridėti bylas į sąrašą“ dar kartą ir išsirinkite reikiamas bylas.
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Pastabos dėl darbo su BatchConv įrankiu:

– Jei  norite  vienu  metu  pridėti  kelias  bylas  –  pasinaudokite  „Shift“  ar  „CTRL“  klavišais  bylų 

pasirinkimo dialoge (jį iškviečia mygtukas „Pridėti bylas į sąrašą“).

– Visas  pasirinktas  bylas  konvertuoja  į  vieno  tipo  formatą,  pvz.,  galima  ir  „MS  Word“,  ir 

„OpenOffice.org“, ir „MS Excel“ bylas konvertuoti į PDF ar OpenDocument formatą vienu žingsniu.

– Jei norite pašalinti bylą iš sąrašo tiesiog 2 kartus paspauskite ant jos.

– PDF ir Flash formatai palaikomi tik naudojant OpenOffice.org 1.1 ar naujesnę versiją.

– OpenDocument formatas palaikomas tik naudojant OpenOffice.org 2.0 ar naujesnę versiją ir 2005 

metų ar naujesnį BatchConv įrankį.

2 DocConverter įrankis

Šį  įrankį  galite  atsisiųsti  iš  http://converter.openoffice.lt (gamintojo  puslapis  yra 

http://www.ooomacros.org )

Sekančiose ekrano nuotraukose parodyta kaip su  DocConverter įrankiu konvertuoti dokumentus iš 

MS  Office  Word  97/2000/XP  į  OpenDocument  formatą.  Pradžioje  pasirenkame  pradinių  dokumentų 

katalogą  („Source  documents  folder“)  bei  konvertuotų  dokumentų  katalogą  („Destination  documents 

folder“):

Tuomet nurodote kokio tipo dokumentus konvertuosite:
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Galiausiai nurodote į kokį tipą jums reikia konvertuoti ir patikrinate ar viskas nustatyta kaip jums reikia:

41



Šie įrankiai yra padaryti su OpenOffice API, taigi jei jums reikia dokumentų konvertavimo galimybės 

jūsų programinėje įrangoje pasinaudokite šių įrankių programiniu kodu.

 Jei norite konvertuoti dokumentus iš/į OpenDocument formatą naudojant komandinę eilutę (pvz., .bat 

bylose) arba savo ar kitų sukurtose programose galite pasinaudoti šiais programinio kodo pavyzdžiais:

http://www.oooforum.org/forum/viewtopic.php?t=3772

 (šį pvz., turėtų greitai perkelti į http://www.ooomacros.org )

Taip pat galima pasinaudoti internete esančiomis priemonėmis skirtomis dokumentų konvertavimui iš 

OpenDocument į kitus formatus (tame tarpe PDF, RTF, „MS Office“) ir atvirkščiai:

http://converter.openoffice.lt bei http://oooconv.free.fr/oooconv 

Konvertavimo  puslapyje  tereikia  nurodyti  diske  esantį  OpenDocument  ar  kito  OpenOffice.org 

palaikomo formato dokumentą (tekstinį, el. lentelę, prezentaciją ar brėžinį) bei jums reikiamą formatą. 

Tuomet paspaudę nusiuntimo mygtuką galėsite atsisiųsti sukonvertuotą dokumentą.

Šis būdas labai naudingas, kai darbuotojai dirba su silpnais kompiuteriais, kuriuose nėra galimybės 

įdiegti  OpenOffice.org.  Taip pat  oooconv konvertavimo įrankis  (jam reikia OpenOffice.org  paketo bei 

Apache + PHP programinės įrangos, nepriklausomai nuo operacinės sistemos) gali būti įdiegtas į vieną 

kompiuterį vietiniame tinkle ir tuomet visiems įstaigos darbuotojams nebus būtina įdiegti OpenOffice.org 

programinės įrangos.

Paprastus teksto dokumentus konvertuoti galima ir su AbiWord programa (versija 3.x ar naujesne), 

tereikia įdiegti AbiWord su import/export priedais (plugins). Tuomet galima atsidaryti norimą konvertuoti 

dokumentą ir išsaugoti jį reikiamu formatu arba pasinaudoti komandinės eilutės parametrais:

abiword -t FORMAT konvertuojamos_bylos_vardas

kur FORMAT reikšmė gali būti rtf, sxw, doc, txt, utf8, html, latex ir t.t.

Pavyzdys:
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abiword -t doc BatchConv2.0.odt

Ši komanda konvertuoja OpenDocument formato BatchConv2.0.odt dokumentą į „MS Office“ formato 

BatchConv2.0.doc

7.2.4 Išvados

Jei  darbo vieta migruoja nuo komercinės prie laisvos „OpenOffice.org“  biuro programinės įrangos, 

dažniausiai užtenka „OpenOffice.org“ ar „StarOffice“ pakete esančio dokumentų konvertavimo vedlio.

Jei  darbo  vietoje  daugiausiai  dirbama  su  komercine  biuro  programine  įranga  ir  yra  galimybė  į 

kompiuterius arba į nors vieną vietiniame tinkle esantį kompiuterį įdiegti „OpenOffice.org“ ar „StarOffice“ 

paketą, priklausomai nuo reikalingų konvertuoti dokumentų kiekio, rekomenduojama arba paprasčiausiai 

pasinaudoti  OpenOffice.org  pakete  esančia  išsaugojimo  kitu  formatu  galimybe  ar  dokumentų 

konvertavimo  vedliu  (žr.:  „File->Wizards->Document  Converter...“)  arba  pasirinkti  DocConverter ar 

BatchConv įrankius.

Su BatchConv įrankiu  galima labai  patogiai  ir  greitai  visus  (visų tipų)  interneto serveryje  esančius 

uždaro formato dokumentus konvertuoti į pvz., OpenDocument ar PDF formatą – tereikia vietiniame tinkle 

paviešinti (share) serverio katalogus, kuriuose yra dokumentai ir pasirinkti tuos dokumentus su BatchConv 

įrankius, paliekant konvertuotus dokumentus tame pačiame aplanke.

jei nėra galimybės darbo vietoje įdiegti OpenOffice.org paketo konvertavimo darbą galima skirti kitam 

žmogui,  kuris  turi  įdiegtą  OpenOffice  paketą  arba  priklausomai  nuo  konvertuojamų  dokumentų 

sudėtingumo  pasirinkti  serverinį  sprendimą  ar  įdiegti  AbiWord  programą  (3.x  ar  naujesnę  versiją)  ir 

pasinaudoti jos teikiamomis galimybėmis.

Pasinaudojus  OpenOffice.org  pagrindu  padarytomis  dokumentų  konvertavimo  priemonėmis 

nepamirškite patikrinti ar teisingai atrodo konvertuoti dokumentai – ar neišsimėtė punktų numeravimas, ar 

tinkamo dydžio šriftai, ar teisingai atrodo sudėtingos lentelės ir pan.
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8 Dokumentų ir formų priėmimas iš fizinių ir juridinių 
asmenų. Programinė įranga el. formoms

Nors  dabartiniu  metu  valstybės  ir  savivaldos  institucijos  praktiškai  nepriima  duomenų  (sutarčių, 

paraiškų ir pan.) iš privačių fizinių ar juridinių asmenų elektroniniu būdu (išskyrus keletą institucijų kaip 

statistikos departamentas ar valstybinė mokesčių inspekcija),  tačiau greitoje ateityje, plačiau įsigalėjus 

patikimom  fizinių  ar  juridinių  asmenų  elektroninio  identifikavimo  technologijom,  pvz.,  elektroniniam 

parašui, šios paslaugos bus vis plačiau teikiamos. Todėl priimant sprendimus, pvz., ruošiant programinės 

įrangos, skirtos duomenų priėmimui iš fizinių ar juridinių asmenų, įsigijimo konkurso sąlygas, yra svarbu 

žinoti,  kokias  technologijas  ir  kokius  formatus  geriausia  naudoti  duomenų  priėmimui  iš  gyventojų  ar 

įmonių. Svarbiausia yra įsitikinti, kad naudojamos technologijos bei duomenų formatai ir protokolai bus 

atvirieji, priešingu atveju gyventojai ir įmonės bus verčiami pirkti arba nelegaliai naudotis vieno gamintojo 

ar uždaros gamintojų grupės programine įranga. Atvirųjų formatų duomenų priėmimui elektroniniu būdų 

yra pakankamai, tereikia tik pasirinkti kuris jums labiausiai tinka. Duomenys iš fizinių ar juridinių asmenų 

dažniausiai  priimami  formų  pavidalu.  Elektroninėms  formoms  šiuo  metu  yra  tokie  atvirieji  atvirieji 

standartai:

– nedidelio ir vidutinio sudėtingumo el. formoms pildyti geriausiai tinka plačiai paplitęs ir daugelio 

gamintojų programinės įrangos palaikomas (X)HTML formatas. per HTTPS protokolą.

– Sudėtingesnėms  formoms  yra  XForms  (http://www.w3c.org/MarkUp/Forms)  bei  PDF  forms 

formatai, taip pat universalusis OpenDocument formatas.

OpenDocument formatas taip pat tinka ir kitais atvejais, kai duomenys yra ne formų, o kitokiu (pvz., 

brėžinio ar elektroninės lentelės) pavidalu. OpenDocument verta pasirinkti ir dėl to, kad šis formatas turi 

integruotą skaitmeninio parašo galimybę.

Pateiksime pavyzdį kaip su OpenOffice.org 2.0 sukurti PDF formą iš paprasto tekstinio dokumento:

1. Pradžioje atsidarykime reikiamą tekstinį dokumentą (arba sukurkime naują, žr.: „File->New-

>XML Form Document“)

2. Jei nėra įjungta formų kūrimo bei formos elementų mygtukų juosta tai įjunkite ją – uždėkite 

varneles ant „View->Toolbars->Form Design“ bei „View->Toolbars->Form Controls“

3. Jei neįjungtas tai įjunkite formos kūrimo režimą – formos kūrimo mygtukų juostoje paspauskite 

„Design Mode On/Off“ mygtuką.

4. Susikurkite reikiamą formą – sudėkite jums reikiamus formos elementus, pavyzdžiui taip:
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5. Eksportuokite sukurtą formą į PDF formatą – iš File meniu išsirinkite „Export as PDF“

6. Viskas, PDF forma sukurta, galime pabandyti ją užpildyti su pvz., Adobe Reader:

45



9 Priedai

9.1 Terminų žodynas

HTML (HyperText Markup Language) Hipertekstinių  dokumentų aprašymo kalba.  HTML yra  vienas iš 
svarbiausių  žiniatinklio  atvirųjų  standartų.  HTML (HyperText 
Markup Language)  yra WWW  (World Wide Web)  konsorciumo 
(www.w3.org) standartizuojamas formatas.

XHTML (The Extensible HyperText 
Markup Language)

HTML  kalbos  variantas  pagrįstas  atitinkantis  XML  kalbos 
reikalavimus.  XHTML  dokumentus  galima  apdoroti  daugybe 
egzistuojančių įrankių, skirtų darbui su duomenimis XML formatu. 
XHTML pašalintos nereikalingos HTML dalys, įdiegtas papildomas 
funkcionalumas (tobulesnis formų veikimas).

XML (Extensible Markup Language) Išplėstinė  dokumentų  aprašymo  kalba.  XML  tai  formatas, 
leidžiantis struktūrizuotu tekstiniu pavidalu aprašyti duomenis.

CSS (Cascading Style Sheets) Pakopinių  stilių  schemos.  CSS  leidžia  tiksliai  aprašyti  HTML 
dokumentų išvaizdą bei išdėstymą.

Svetainė, tinklapis Vienai temai skirti, bendra idėja susieti HTML dokumentai.
WWW (World Wide Web) Žiniatinklis, hipertekstinių dokumentų sistema internete.
W3C (World Wide Web Consortium) Organizacija, vystanti WWW standartus (http://www.w3c.org).
Naršyklė Programa WWW  peržiūrai. Tai gali būti „Mozilla“,  „Firefox“, „MS 

Internet Explorer“, „Opera“, daugybė kitų.
JPEG Atviras elektroninių paveikslėlių formatas, standartizuojamas Joint 

Photographic Experts Group(www.jpeg.org). 
OpenDocument (Open Document 

Format for Office Applications) 
Tarptautinio  konsorciumo  OASIS (Organization  for  the 
Advancement of  Structured Information Standards -  www.oasis-
open.org) standartizuojamas biuro dokumentų formatas, sukurtas 
XML formato pagrindu.

PDF (Portable Document Format) Kompanijai  „Adobe“  priklausantis,  tačiau  atviras  formatas.  Yra 
sukurta laisvos programinės įrangos, palaikančios PDF formatą, 
tačiau ne visos jos pilnai palaiko visas PDF formato galimybes.

XForms Specializuotas formatas (standartas), skirtas įvairių formų pildymui 
bei į formas įvestų duomenų tikrinimui ir perdavimui internetu. Tai 
nepriklausomas  standartas,  standartizuojamas  WWW  (World 
Wide Web) konsorciumo (www.w3.org/MarkUp/Forms/).

IDABC (Interoperable Delivery of 
European eGovernment Services to 
public Administrations, Businesses 
and Citizens) 

Europos  Komisijos  programa,  skatinanti  atvirųjų  standartų 
naudojimą viešajame sektoriuje17. IDABC programos pagrindiniai 
tikslai: skatinti ir remti visos Europos elektroninės valdžios viešųjų 
paslaugų  teikimą  viešojo  administravimo  institucijoms, 
gyventojams  ir  verslo  subjektams,  pagerinti  Europos  viešojo 
administravimo  institucijų  veiksmingumą  ir  tarpusavio 
bendradarbiavimą,  siekti,  kad  Europa  taptų  patrauklia  vieta 
gyventi, dirbti ir investuoti. 

OASIS (Organization for the 
Advancement of Structured 
Information Standards)

Tarptautinis ne pelno siekiantis el. verslo standartų konsorciumas 
http://www.oasis-open.org

9.2 Lietuvos Respublikos teisės aktai

Žemiau pateikiami pagrindiniai Lietuvos Respublikos Vyriausybės nutarimai, reglamentuojantys 

elektroninę valdžią bei viešojo administravimo plėtrą Lietuvoje.

● Dėl Lietuvos informacinės visuomenės plėtros strateginio plano patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184 

(Lietuvos Respublikos Vyriausybė/Aktuali redakcija/984/2002 06 20/Aktuali nuo 2002 06 20/ )

17 http://europa.eu.int/idabc  

46

http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184
http://www.oasis-open.org/
http://europa.eu.int/idabc
http://www.w3.org/MarkUp/Forms/
http://www.oasis-open.org/
http://www.oasis-open.org/
http://www.jpeg.org/
http://www.w3c.org/
http://www.w3.org/


● Dėl Lietuvos informacinės visuomenės plėtros strateginio plano patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=147527 

(Lietuvos Respublikos Vyriausybė/Nutarimas/984/2001 08 10/įsigaliojo nuo 2001 08 18/Valstybės 

žinios'2001 Nr.71-2534)

● Dėl Elektroninės valdžios koncepcijos patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=198184 

(Lietuvos Respublikos Vyriausybė/Nutarimas/2115/2002 12 31/Įsigaliojo nuo 2003 01 09/Valstybės 

žinios'2003 Nr.2-54)

● Dėl bendrųjų reikalavimų valstybės institucijų interneto svetainėms patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=209540 

(Lietuvos Respublikos Vyriausybė/Nutarimas/480/2003 04 18/Įsigaliojo nuo 2003 04 25/Valstybės 

žinios'2003 Nr.38-1739)

● Dėl elektroninės valdžios koncepcijos įgyvendinimo priemonių plano patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=222092 

(Lietuvos Respublikos Vyriausybė/Nutarimas/1468/2003 11 25/Įsigaliojo nuo 2003 11 29/Valstybės 

žinios'2003 Nr.112-5022)

● Dėl keitimosi informacija apie standartus, techninius reglamentus ir atitikties įvertinimo procedūras 

taisyklių patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=232235 

(Lietuvos Respublikos Vyriausybė/Aktuali redakcija/617/2004 04 26/Aktuali nuo 2004 04 26/ )

● Dėl Viešojo administravimo plėtros iki 2010 metų strategijos patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=232235 

(Lietuvos Respublikos Vyriausybė/Nutarimas/488/2004 04 28/Įsigaliojo nuo 2004 05 01/Valstybės 

žinios'2004 Nr.69-2399)

● Dėl Lietuvos Respublikos informacinės visuomenės paslaugų įstatymo koncepcijos patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=242991 

(Lietuvos Respublikos Vyriausybė/Nutarimas/1276/2004 10 11/Įsigaliojo nuo 2004 10 15/Valstybės 

žinios'2004 Nr.151-5497)

● Dėl Viešojo administravimo plėtros iki 2010 metų strategijos įgyvendinimo 2005-2006 metų priemonių 

plano patvirtinimo

http://www3.lrs.lt/cgi-bin/preps2?Condition1=250676 

(Lietuvos Respublikos Vyriausybė/Nutarimas/197/2005 02 21/Įsigaliojo nuo 2005 02 25/Valstybės 

žinios'2005 Nr.26-830)

9.3 Naudingos nuorodos

9.3.1 Europos Komisijoje

- Interoperable Delivery of European eGovernment Services to public Administrations, Businesses and 

Citizens (IDABC) - http://europa.eu.int/idabc/
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- Europos informacinė visuomenė - http://europa.eu.int/information_society/index_en.htm

9.3.2 Lietuvoje

- LR Seimo Informacinės visuomenės plėtros komitetas - www.lrs.lt/ivpk

- Informacinės visuomenės plėtros komitetas prie Lietuvos Respublikos Vyriausybės (IVPK) - 

http://www.ivpk.lt, http://atviraskodas.ivpk.lt 

- Vidaus reikalų ministerijos Informacinės politikos departamentas  http://www.vrm.lt/index.php?id=218

- Standartizacijos departamentas prie Aplinkos ministerijos - www.lsd.lt

- Visuomeninė organizacija „Atviras kodas Lietuvai“ (AKL) - www.akl.lt 

- Laisva programinė įranga biurui - www.openoffice.lt

- Matematikos ir informatikos institutas (MII, lokalizuoja laisvą programinę įrangą OpenOffice.org, 

Mozilla ir kt.) - www.mii.lt

- Asociacija „Infobalt“ - www.infobalt.lt

- Lietuvos kompiuterininkų sąjunga - http://www.liks.lt

9.3.3 Latvijoje

- Regioninės plėtros ir savivaldybių ministerija - http://www.raplm.gov.lv/eng/

- Specialiosios paskirties elektroninių paslaugų ministro sekretoriatas - http://www.eps.gov.lv

- Visuomeninė organizacija „Latvijos atvirojo kodo asociacija“ (LAKA) - http://www.laka.lv

- Latvijos informacinių technologijų ir telekomunikacijų asociacija (LITTA) - http://www.litta.lv/en/

9.3.4 Naudingi informacijos šaltiniai

- eGovernment Observatory – e. Valdžios apžvalgininkas (http://europa.eu.int/idabc/en/chapter/140) 

- Open Source Observatory – Atvirojo kodo apžvalgininkas (http://europa.eu.int/idabc/en/chapter/452) 

- World Wide Web Consortium – Interneto standartus prižiūrinti organizacija - http://www.w3c.org

- HTML kalbos svetainė (http://www.w3c.org/MarkUp/)

- XForms formato (standarto), skirto įvairių formų pildymui bei į formas įvestų duomenų tikrinimui ir 

perdavimui svetainė (www.w3.org/MarkUp/Forms/)

- HTML 4.01 specifikacija (http://www.w3.org/TR/html4/)

- CSS 2.1 specifikacija (http://www.w3.org/TR/CSS21/)

- HTML tikrinimo paslauga (validatorius) - http://validator.w3.org

- CSS validatorius - http://jigsaw.w3.org/css-validator/

- OpenDocument formatas – atsakymai į dažnai užduodamus klausimus– http://www.oasis-

open.org/committees/office/faq.php 

- Atvirojo dokumento formato palyginamoji rinkos apžvalga – 

http://europa.eu.int/idabc/servlets/Doc?id=17982

- Su atvirojo duomenų mainų formato skatinimu susiję dokumentai – 

http://europa.eu.int/idabc/en/document/3439 ; http://europa.eu.int/idabc/en/document/3428 
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- OASIS - Organization for the Advancement of Structured Information Standards – http://www.oasis-

open.org

- Universalūs laisvi šriftų, turintys daugelio tautų simbolius (TrueType, Type1 ir OpenType formatais) - 

http://www.freesoftware.fsf.org/freefont 

9.3.5 Naudinga programinė įranga

- Geriausiai standartus atitinkanti naršyklė „Mozilla Firefox“ bei el. pašto programa „Mozilla Thunderbird“ 

- http://www.mozilla.org

- Laisva biuro programinė įranga, palaikanti daug atvirų ir uždarų formatų - www.openoffice.org

- Galingas ir patogus vartotojui Interneto puslapių kūrimo įrankis - http://www.nvu.com

- HTML Kit rengyklė - http://www.chami.com/html-kit/

- Atvirus ir uždarus suspaudimo formatus (zip, gzip, rar, 7-zip, cab ir t.t.) palaikantis archyvatorius – 

www.7-zip.org

- PDF konvertavimui skirtas įrankis (virtualus PDF spausdintuvas) – www.pdfcreator.de.vu

49

http://www.pdfcreator.de.vu/
http://www.7-zip.org/
http://www.chami.com/html-kit/
http://www.nvu.com/
file:///mnt/data/PHARE_ataskaitai/II_ketvirtis/UsersGuideBook/www.openoffice.org
http://www.mozilla.org/
http://www.freesoftware.fsf.org/freefont
http://www.oasis-open.org/
http://www.oasis-open.org/


VO „Atviras kodas Lietuvai“

P.Vileišio g. 18, 1 korp., LT-10306 Vilnius

Tel./faks. (8-5) 210 4005

El. paštas info@akl.lt

http://www.akl.lt

Vilniaus miesto savivaldybė

Konstitucijos pr. 3, LT-09601 Vilnius

Tel. (8-5) 211 20 00

Faks. (8-5) 211 22 22

http://www.vilnius.lt

Latvijos atvirojo kodo asociacija

Melgnaila 1a, Riga, LV-1010 Latvia
Tel. +371 6406182
Faks. +371 7144620
http://www.laka.lv
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